<table>
<thead>
<tr>
<th>R#</th>
<th>status</th>
<th>Performed by</th>
<th>Description of Change</th>
<th>Date</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>DRAFT</td>
<td>Billy Lai / CLT</td>
<td>Initial draft.</td>
<td>April 17, 2009</td>
<td>All</td>
</tr>
<tr>
<td>0.2</td>
<td>RELEASE</td>
<td>Billy Lai / CLT</td>
<td>Release V3.1.0</td>
<td>June 05, 2009</td>
<td>some</td>
</tr>
<tr>
<td>0.3</td>
<td>RELEASE</td>
<td>Billy Lai</td>
<td>Updated images</td>
<td>Nov 11, 2009</td>
<td>All</td>
</tr>
<tr>
<td>0.4</td>
<td>RELEASE</td>
<td>Billy Lai</td>
<td>Release V3.2.0</td>
<td>Jan. 11, 2010</td>
<td>All</td>
</tr>
<tr>
<td>0.5</td>
<td>RELEASE</td>
<td>Billy Lai</td>
<td>Release V4.0.0</td>
<td>Apr. 8, 2010</td>
<td>All</td>
</tr>
<tr>
<td>0.6</td>
<td>RELEASE</td>
<td>Billy Lai</td>
<td>Release V4.1.0</td>
<td>Nov. 22, 2010</td>
<td>All</td>
</tr>
<tr>
<td>0.7</td>
<td>RELEASE</td>
<td>Billy Lai</td>
<td>Release V4.2.0</td>
<td>Feb. 22, 2011</td>
<td>All</td>
</tr>
<tr>
<td>0.8</td>
<td>Legacy</td>
<td>Lou Bonaventura</td>
<td>Rebranded to Oracle and published as Legacy Documentation.</td>
<td>August 2015</td>
<td>All</td>
</tr>
</tbody>
</table>
# Table of Contents

1 Introduction .......................................................................................................................... 3
  1.1 PURPOSE ......................................................................................................................... 3
  1.2 INTENDED AUDIENCE ................................................................................................. 3
  1.3 GUIDE CONVENTIONS ................................................................................................. 3

2 Oracle SAMMAsolo System Overview ................................................................................. 4
  2.1 SAMMASOLO OVERVIEW .......................................................................................... 4
      2.1.1 General Operation ................................................................................................. 4
      2.1.2 Real Time Analysis .............................................................................................. 4
  2.2 SAMMASOLO THEORY OF OPERATION AND WORKFLOW ........................................ 5
      2.2.1 Source Inputs ........................................................................................................ 5
      2.2.2 SAMMAsolo signal and data flow ..................................................................... 5
      2.2.3 Data Analysis screen ......................................................................................... 6
      2.2.4 Other Information ............................................................................................... 6

3 SAMMAsolo System ............................................................................................................. 8
  3.1 INSTALLATION ............................................................................................................. 8
  3.2 GETTING STARTED WITH SAMMASOLO .................................................................. 8
      3.2.1 Prerequisites ......................................................................................................... 8
      3.2.2 Starting SAMMAsolo .......................................................................................... 9
      3.2.3 Remote Procedure Call (RPC) Tasks .................................................................. 11
      3.2.4 Factory Templates .............................................................................................. 11
      3.2.5 Begin a Migration ............................................................................................... 12
      3.2.6 Monitoring the Migration Progress .................................................................. 13
      3.2.7 Migration Termination ..................................................................................... 14
  3.3 ADMINISTRATOR LOGIN ............................................................................................ 15
      3.3.1 Changing the Administrator Password ............................................................... 15
  3.4 MULTILANGUAGE SUPPORT ....................................................................................... 16
      Japanese User Interface ............................................................................................... 18

4 Operating System and Third Party Applications ................................................................. 19
  4.1 OPERATING SYSTEM CONFIGURATION ................................................................. 19
  4.2 MICROSOFT SECURITY ESSENTIAL ......................................................................... 19
  4.3 TEAMVIEWER ............................................................................................................ 20
  4.4 ULTRAVNC .................................................................................................................. 20
  4.5 FILEZILLA FTP SERVER ............................................................................................. 21

5 Migration Control Screen ................................................................................................... 22
  5.1 GENERAL LAYOUT ...................................................................................................... 22
  5.2 SOURCE VTR REMOTE ............................................................................................. 22
      5.2.1 Remote LED .......................................................................................................... 23
      5.2.2 Servo LED ........................................................................................................... 23
5.2.3 Channel Condition LED .......................................................... 23
5.2.4 Tape Time Code ................................................................. 23
5.2.5 Mark In Time Code ............................................................. 23
5.2.6 Mark Out Time Code ......................................................... 23
5.2.7 Duration ........................................................................... 23
5.2.8 Stop .................................................................................. 23
5.2.9 Rewind .............................................................................. 23
5.2.10 Play .................................................................................. 23
5.2.11 Fast Forward ................................................................. 23
5.2.12 Pause ................................................................................ 23
5.2.13 Eject ............................................................................... 23

5.3 INPUT ANALYSIS .................................................................... 24
5.3.1 Video Present LED ............................................................. 24
5.3.2 Recorded Time Code .......................................................... 24
5.3.3 Level Monitors ................................................................. 24

5.4 MIGRATION ............................................................................. 24
5.4.1 Status LED ........................................................................ 24
5.4.2 Migrate Button .................................................................. 24
5.4.3 Elapsed Time .................................................................... 25
5.4.4 Preview Window .............................................................. 25

5.5 OUTPUT DEVICE – JPEG2000 MXF ......................................... 25
5.5.1 Status LED ....................................................................... 25
5.5.2 Real Time Bit Rate Calculation ....................................... 25
5.5.3 Disk Space Indicators ....................................................... 25

5.6 OUTPUT DEVICE – SAMMA MULTICODER ................................ 25
5.6.1 Status LED ....................................................................... 26
5.6.2 Real Time Bit Rate Calculation ....................................... 26
5.6.3 Disk Space Indicators ....................................................... 26

5.7 OUTPUT DEVICE – DUB VTR ................................................... 26
5.7.1 VTR Controls .................................................................. 26

5.8 MESSAGE LOG ...................................................................... 26

6 SAMMAsolo Menu Options .......................................................... 27
6.1 TOOLBAR MENU .................................................................. 27

6.2 FILE .................................................................................... 27
6.2.1 New from Template (SXT) ............................................. 28
6.2.2 New from Database ....................................................... 28
6.2.3 Open ............................................................................... 29
6.2.4 Save ............................................................................... 29
6.2.5 Save As .......................................................................... 29
6.2.6 Print Page Setup ............................................................ 30
6.2.7 Recent Documents .......................................................... 30
6.2.8 Exit ............................................................................... 31

6.3 CONFIGURATION .................................................................. 31
6.3.1 Administrator ................................................................. 31
6.3.1.1 Administrator Log In .................................................. 31
6.3.1.2 Administrator Log Out ............................................... 31
**TUV (United States, Canada only)**
This product was tested and was certified by TUV to UL/EN/IEC60950 and CAN/CSA-C22.2 No.60950-0-1-03 standards and carries the TUV mark for Canada and USA.

**CE Manufacturer Declaration (European Community only)**
Oracle declares that the equipment described in this document is in conformance with the requirements of the European Council Directive listed below:

This equipment is in compliance with the essential requirements and other provisions of European Directives 2006/95/EC and 2004/108/EC as well as compatible USA and Canadian regulations:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regulatory Laws</td>
<td>Products with the CE Marking are compliant with the 2006/95/EC and 2004/108/EC directives, which include the safety and EMC (emissions and immunity) standards listed.</td>
</tr>
<tr>
<td>Safety Standard</td>
<td>EN/IEC 60950-1</td>
</tr>
<tr>
<td>EMC Standard</td>
<td>EN 55022 Class A (CISPR 22) emissions (Int’l and EU)</td>
</tr>
<tr>
<td></td>
<td>EN 55024 (CISPR 24) immunity (EU)</td>
</tr>
</tbody>
</table>

**FCC Class A Notice (USA and Canada Only)**
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference.
- This device must accept any interference received, including interference that may cause undesired operation.

**Note:**
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy, and if it is not installed and used in accordance with the instruction manual, it may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his/her own expense.

**Shielded Cables:** Connections between the Solo and peripherals must be made using shielded cables to comply with FCC radio frequency emission limits. Networking connections can be made using unshielded twisted-pair (UTP) cables.

**Modifications:** Any modifications made to this device that are not approved by Oracle may void the authority granted to the user by the FCC to operate this equipment.

**ICES-003 Class B Notice (Canada Only) - Avis NMB-003, Classe B**
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations ICES-003.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur NMB-003 du Canada.
Regulatory Compliance Statement For Directive 2002/95/EC (RoHS)
Oracle hereby declares, that the following items listed in Directive 2002/95/EC are not intentionally added to any Oracle products, including all components:

- Lead
- Mercury
- Cadmium
- Hexavalent chromium
- Polybrominated Biphenyls (PBB)
- Polybrominated Diphenyl Ethers (PBDE),

To the best of our knowledge, our raw material suppliers also do not intentionally add these elements to the products we purchase.

This statement is based on knowledge as of the date of issue. Oracle makes no warranties, express or implied, and assumes no liability in connection with use of this information outside of Oracle control.

NOM Information (Mexico Only)
The following information is provided on the device described in this document in compliance with the requirements of the official Mexican standards (NOM):

Exporter: Oracle Corporation
Importer: -TBD-
Ship to: -TBD-
Supply voltage: 100–240 V~
Frequency: 47–63 Hz
Input current rating: 10 - 5 A

Product Disposal

This product complies with the WEEE 2002/96/EC Directive from the European Community. According to local laws and regulations this product should be disposed of separately from household waste. When this product reaches its end of life, contact FPDI or your local authorities to learn about recycling options.

Your main processor board uses a lithium battery. The lithium is a long-life battery, and it is very possible that you will never need to replace it. However, should you need to replace it, refer to the motherboard manufacturer for replacement instructions.

Do not dispose of the battery or any other component along with household waste. Contact your local waste disposal agency for the address of the nearest battery deposit site.
1 Introduction

1.1 Purpose
This document is intended to provide instructions on set up and the usage of Oracle SAMMAsolo v4.2.0.

1.2 Intended Audience
The intended audiences for this document are SAMMAsolo administrators. This document provides detailed instructions for setting up and using SAMMAsolo.

1.3 Guide Conventions
The following conventions in this guide are used in respect of text:

- **Normal** Standard Text.
- *Italic* Used to emphasize a term or variable.
- **Bold** Used to emphasize critical information.
- §6.1 Refers to a section or sub-section in the document.

About → these → arrows

This manual contains instructions like ‘Select File→New→Template.sxt’ which is shorthand for a longer instruction directing the user to open two nested commands in sequence: Click the File menu to display it. Click ‘New’ in the File menu. Inside the New window is a file named Template.sxt. Highlight the name and click to open it.”

Apostrophes

Words that the user is expected to look for on the computer screen are bracketed by apostrophes as in ‘Tape Details’. The same term may be used in context without apostrophes, meaning that it is not particularly important to look at Solo’s screen just then.

NTSC, PAL and SECAM

Solo can operate in any of the major worldwide television standards. Although NTSC is used for examples and screenshots, this manual covers all Solos, whether configured for NTSC, PAL or SECAM. This manual does not instruct the user on how to change Solo from one television standard to another. This change would require different VTRs and settings for the Analysis Engine, SAMMA Eye, and encoders.¹ For assistance please contact the Oracle Customer Service Team.

SAMMAsolo, Solo, SammaSolo and other SAMMA names

SAMMAsolo, or Solo, is the name of this product including all of its software and hardware. SammaSolo, or SammaSolo.exe, is the name of the core software application that the user sees on Solo’s computer monitor. SAMMA Eye is a software application that runs in the background, configured by screens within SammaSolo.exe. SAMMA Analysis Engine is a hardware and software combination inside Solo, also configured by screens in SammaSolo.exe.

¹ Videotapes must be played back by a VTR supporting the standard in which they were originally recorded. Solo does not perform standards conversion, i.e., Solo cannot convert video from one television standard to another as in 525/60 NTSC to 625/50 PAL or vice versa. Nor can Solo control a VTR in one standard while capturing video in another standard, even if the video is processed in real-time through an external standards converter. Solo will migrate a standards-converted videotape with an appropriate VTR.
2 Oracle SAMMAsolo System Overview

2.1 SAMMAsolo Overview

2.1.1 General Operation

The SAMMAsolo efficiently migrates archival videotapes to digital files. A single Solo is designed to migrate one videotape at a time, outputting one or several simultaneous digital formats. If more throughput is desired, several Solos can be controlled by a single user from one master Solo. For larger libraries, the SAMMA Robot combines up to six Solos with a robotic tape-handling system for 24/7 operation and the greatest possible efficiency.

In one real-time pass, depending on the encoder cards installed, a Solo can simultaneously encode to a number of file types, including:

- MXF-wrapped JPEG 2000
- MPEG-1
- MPEG-2
- MPEG-4 (H.264)
- QuickTime MOV
- AVI
- Flash 8
- DV 25
- Windows Media 11

While other compression techniques typically create artifacts whose effects cannot be reversed, JPEG 2000 offers a fully reversible and mathematically lossless encode for an enduring archival copy. Oracle is a world leader in the implementation of real time JPEG 2000, an open ISO standard that offers lossless video compression at about a third the storage size of uncompressed video.²

2.1.2 Real Time Analysis

Solo’s Analysis Engine™ and SAMMA Eye™ can automatically monitor, repair and log video and audio quality for every frame of video that they handle. The Analysis Engine offers the following signal processing:

- Full Frame Synchronizer
- RF Dropout Compensation (U-matic only)
- Time Code Generator
- Digital Comb Filter
- AGC (Auto Gain Control)
- ACC (Auto Chroma Control)
- CTI (Chroma Transition Improvement)
- NR (Digital Noise Reduction)

A user can pre-set up to six sensitivity thresholds with Solo’s SAMMA Eye. If these levels exceed the user-defined duration, Solo can be set to automatically end a migration in order to avoid wasting time and storage, or to detect video segments for logging purposes, etc.

All the data logged during a migration – often as much as 30 MB or more – is saved in an XML document to provide a baseline for analysis and ongoing preservation and restoration work. Users can examine a migration using Solo’s Data Analysis tool to graphically illustrate the migration’s XML information.

² For more about JPEG 2000, see
www.iso.org/iso/iso_catalogue/catalogue_tc/catalogue_detail.htm?csnumber=41570
and www.digitalpreservation.gov/formats/fdd/fdd000127.shtml
Solo’s Windows XP operating system ensures easy installation and training. User configurations can be saved in templates so that multiple collections can be migrated with different video tolerances or adjustments if desired, while keeping collections consistent within themselves.

Solo includes audio, analog and Serial Digital Interface (SDI) video outputs for additional monitoring.3

2.2 SAMMA solo Theory of Operation and Workflow

2.2.1 Source Inputs

After the user has selected a template and/or manually set migration parameters, and entered identifying information about the videotape (perhaps via barcode scan), Solo assumes control of the source VTR and optional Dub VTR.4 Source video and audio are digitized to the CCIR 601 standard (SDI), frame-synchronized and time-base corrected. This SDI signal is routed internally to video encoders and externally to a BNC connector, along with a copy of the source analog video (BNC) and analog audio (XLR) for use with external video recorder(s) and monitors.

2.2.2 SAMMA solo signal and data flow

During a migration the digital video and data files are cached on Solo’s internal F drive. The user can choose to monitor the migrating video and audio (for logging or other reasons), or attend to other duties (perhaps other Solos) and return when the migration is complete. Solo will determine when the migration should end.

---

3 Monitors sold separately.
4 Requires VTR with Sony 9 pin RS-422 control.
according to targets set by the user, such as a long section of black, a time code mark out, a preset duration, a threshold of time with no video or servo lock, etc.

When the user agrees that the migration is complete (by clicking 'OK'), the cached files are processes and moved to the folder F:\Success on Solo’s internal RAID-0 disk array for retrieval by the user’s deeper storage or asset management system. Solo can also move completed files to networked destinations.

Well over 200 metrics about the migration are found in Solo’s XML output file, including file names, destinations, encoder settings, timings, video measurements, shot list, black detection, audio silence, checksums and so on. All encoded files have the same base name, distinguished by their file extensions, i.e., .mxf, .wmv, .xml, etc.

### 2.2.3 Data Analysis screen

Solo can read a migration’s XML data and graphically display its video and audio levels, drop outs and RF level, input presence and servo lock, with scrolling and magnification. This data analysis can be useful in logging, detecting video problems, etc.\(^5\)

### 2.2.4 Other Information

Many users have library management and/or media asset management systems. Solo can import a user’s CSV file(s) to its internal SQL database, and/or from the optional SAMMA Prep accessioning workstation sometimes used with the optional SAMMA Clean. Solo adds more data during migration and saves it all as XML for re-absorption to the user's source database.

Most users intend to distribute compressed copies of their migrated videos. Solo is not a video editor or a transcoder.

For archival purposes it is usually appropriate to migrate the tape as is, though migrated files may contain unnecessary black or color bars, and sometimes multiple program segments, depending on the content of the source video. If desired, files may also be trimmed and edited with third party video editors, as well as logged and/or ingested into an asset management system.

\(^5\) XML output files can be viewed immediately after migration is complete, or at any later time. Solo does not display a migration’s XML data during the migration.
Archived videotapes often suffer from physical damage and/or decay of the tape binder chemicals, leading to visible errors from loss of magnetic particles. Tape care with an optional SAMMA Clean, careful maintenance of the VTR and signal path, and Solo’s electronic processing will minimize these errors, but they rarely eliminate them completely. Third party restoration products can further enhance content quality and may be used immediately after migration or later when the video is needed in a production workflow.
3 SAMMAsolo System

3.1 Installation

Solo is designed for flexibility of installation. Because many users need to bring Solo to their videotapes and not vice versa, Solo can be set up on a desktop or a rack shelf. Other equipment like a VTR, audio/video monitoring or Solo's own VGA monitor may be set on top of Solo. The user can connect and configure Solos in many ways for different collections or source tape formats. Solos can be connected to:

- Source VTRs
- Dub VTRs
- Audio and video routers
- External encoders
- House time code, sync
- Video monitors
- Audio monitors.

Solo Back Panel

See Appendix A: Solo Connections for set up details. Solo connects to a Local Area Network (LAN) with standard Windows XP and TCP/IP methods.

It is important to give the Oracle Customer Service Team remote access to SAMMAsolo

Solo ships with UltraVNC and TeamViewer installed so the Oracle Customer Service Team can assist Solo users remotely. For assistance, contact the Oracle Customer Service Team.

3.2 Getting started with SAMMAsolo

3.2.1 Prerequisites

Start by collecting the session's videotapes for migration (and blank tapes for a Dub VTR, if required). If the videotapes were prepared in advance with SAMMA Prep, or they otherwise contain barcode labels for scanning during migration, please see also the chapter Metadata: XML and Import/Export.
Many users choose to clean their tapes with an optional SAMMA Clean before migrating video. The cleaning process operates at about ten times faster than real time so the user may clean tapes ahead of time or in a separate location from Solo.

Check that the VTR(s) are powered on and in remote mode. Solo may not be able to establish control of a VTR if it is not powered on when the SammaSolo application launches and tries to establish communication, possibly requiring a restart of the VTR’s RPC (see below).

Check that optional video and audio monitors are turned on. The Solo can be switched on by pressing the power button on Solo’s front panel.

3.2.2 Starting SAMMA Solo

The system should log in automatically. If not, the user must log in to Solo through the Windows XP login screen. The factory default is username “samma” with the password “samma” (case sensitive). The user may change these in Windows Control Panel→Users. If the defaults are changed please notify the Oracle Customer Service Team. After login, the desktop should appear as below. The top left area icons are SAMMA applications, the bottom left icons are basic Windows 7 applications.

Remote Procedure Calls (RPC) applications run in invisible service mode. The RPC applications are the drivers for the hardware in the Solo. By default, PRC services will automatically start. Possible elements and corresponding RPCs are:

- Source VTR (required), called RPCVTR
- Source Firewire VTR (optional), called RPCFwVTR
- SAMMA Robot (optional), called PRCRobot
- SAMMA Analysis Engine (required), called RPCTBC
- Dub VTR (optional), called RPCVTRdub
- Barcode scanner (optional), called RPCScanner
- JPEG 2000 encoder (optional), called RPCJ2K
- SAMMA Multicoder (optional), called RPCSME
- SAMMA Clean (optional), called RPCCleaner.

(*Remark: RPCVTR and RPCFwVTR cannot run simultaneously. If both services are running, Solo cannot operate.)
A “SAMMA RPC Service Manager” application shortcut is available on the desktop and allows the start-up and visibility of the RPC applications to be changed. It also handles restarts of RPC better and has the ability to override connected RPCs from the SAMMA applications.

For the first time login, change the time zone to the current location and update with the internet time in the Date and time setting.

Click ‘Update now’ to synchronize with time if machine is connect with Internet; otherwise change time manually.
3.2.3 Remote Procedure Call (RPC) Tasks

On the desktop, there is a shortcut called ‘SAMMA RPC Service Manager’. This Service Manager configures the RPC services, stop and start the service.

![SAMMA RPC Service Manager](image)

3.2.4 Factory Templates

Each Solo ships from the factory with a basic selection of settings and templates, all of which can be customized. These templates are located in two folders on the Solo desktop, labeled NTSC Templates and PAL Templates. Each folder contains the same selection of SXT templates but in each standards:

- IMX_D10_MXF_ARCHIVE_8Ch-Audio
- LOSSLESS_J2K_8BIT
- LOSSLESS_J2K_108BIT
- LOSSLESS_J2K_MPEG2_15MB_ARCHIVE
- LOSSLESS_J2K_QT_PJPG_ARCHIVE
- LOSSY_J2K_8BIT_10Mb
- MPEG2_15MB_QT_PJPG_ARCHIVE
- MPEG2_50MB_QT_PJPG_ARCHIVE
- QT_PJPG_FLASH
- UNC_AVI_ARCHIVE
- UNC_MOV_ARCHIVE

Open the appropriate folder and select the desired template. For ease of operation, you can right-click on the desired template and select ‘create shortcut’. This will create a duplicate template icon on the desktop. The operator may rename the new template icon if required.

The expert user with administrator privileges can modify these settings and save them as new templates. Once set up, templates probably do not need to be changed by the day-to-day operator, and in fact it may be undesirable to alter them during the course of migrating a tape collection because the user may prefer to migrate all of the collection’s video with the same settings and workflow policies.

At the start of a migration working shift or workday, it is recommended that the operator calibrate the source VTR so a collection of migrations will remain consistent in its video and audio levels. See the chapter ‘SAMMA Solo Options’ -> ‘Calibrate VTR’ for details.
3.2.5 Begin a Migration

To begin a new migration, select **File->New** from the menu and select a SAMMA XML Template (SXT) to start.
After the window has opened, ensure that the source VTR remote and time code indicators are set and displaying correct values. If any of the components fail to initialize, it will be grayed out or the words “Off line” will be displayed.

Ensure the source VTR operation is controllable via the screen controls (rewind, play etc) and that the Input Analysis recorded time code indicates a valid time code. Check that each encoder is enabled and that there is enough disk space available for the output files. The upper and lower green bars in each encoder component indicate the available space for the cache and final destination locations respectively.

Click the ‘Migrate’ button to begin the videotape migration.

A ‘Tape Details’ dialog will appear. Enter at least a new Tape ID and operator’s name in the Migrated By field. Click ‘OK’ to start the migration.

3.2.6 Monitoring the Migration Progress
The illustration above shows a normal migration:

- Video and audio meters show normal levels, time code advances.
- VTR remote, servo, video present and migration status indicators are green, log shows no error messages.
- Each encoder status indicator is green and that the bytes recorded is increasing and the average bit rate is more than 0 Mb/s.
- Preview window will start after a 10 second delay and will always lag the video encoding by approximately 10 seconds. Audio is also available via the Solo’s earphone or external PC audio connectors.

Solo’s log window displays:

- Time and start of the migration
- VTR movements
- Cue and start of each encoder
- End of each encoding
- Reason for ending
- Error or Success result.

### 3.2.7 Migration Termination

There are several ways for a migration to end. Each reason may have a ‘SUCCESSFUL’ or ‘FAILURE’ status associated with it.
- Normal end of tape, VTR has stopped. (Successful state).
- A mark in/out time code has been triggered. (Successful state)
- A time duration has elapsed. (Successful state).
- User manually stopped the VTR. (Successful state).
- User has pressed the ‘Abort’ button. (User can select either ‘Successful’ or ‘Failure’ state).
- SAMMA Eye event has been triggered. (User configurable state).
- An encoder has encountered an error. This can be directly related to the encoder such as frames dropped or indirectly such as low disk space. (Failure state).
- Output file post-processing error. (Failure state).
- Other hardware or application error. (Failure state).

When the migration is complete, the XML file is automatically saved to the F:\Success directory. Solo can be set to prompt the user to confirm the location for the saved XML file after each tape migration by selecting Configuration→Options to display the ‘General Configuration’ screen, then un-checking the ‘Automatically save XML metadata file after migration’ checkbox. This allows the user to re-confirm the name and location of the XML file to save.

To start a new migration, close the current document window and then select File->New from the menu to begin again.

### 3.3 Administrator Login

Solo is highly configurable to meet needs which can vary between tape library collections as well as between individual tapes. Many of the setup parameters can only be modified by the Administrator. Solo provides an Administrator account for full access to the parameters.

Options that require Administrator login are:

- Analysis Engine Configuration
- Encoder settings, i.e., bit rates, quality etc.

All other options are available for both Administrator and non-administrator (user) accounts.

To login as the Administrator, select Configuration→Administrator→Log In. A message box displays saying “Currently there is no administrator password. Please create one after login.” Click ‘OK’ and you are now in administrator mode.

#### 3.3.1 Changing the Administrator Password

After successful login as Administrator, select Configuration→Administrator→Change Password.

![Administrator Password]

Enter the same password into both fields of the dialog box. Click ‘OK’ to save the new password.
3.4 Multilanguage Support

SAMMA solo V4 onwards is capable of Multilanguage (Unicode) support. Currently only English, Chinese, Korean, Spanish and Japanese User Interfaces are available. Other languages can be made available on request.

Chinese User Interface
Japanese User Interface
4 Operating System and Third Party Applications

4.1 Operating System Configuration
Solo uses Microsoft Windows XP as its operating system. The configuration of the OS has been carefully setup to ensure safe and reliable operation of SAMMA software and hardware. Any unauthorized changes to the OS or installation of third party software may void any warranties applicable to the Solo. If there are any special requirements for third party software to be installed onto the Solo, please contact the Oracle Customer Service team.

The following OS options are enabled or disabled:
- Windows Firewall is enabled
- Windows Update is disabled

The following applications are installed:
- Windows Media Player 11 is installed for SME systems
- AVG Anti-virus/Anti-malware is installed
- TeamViewer remote access software is installed
- UltraVNC remote access software is installed

4.2 Microsoft Security Essential
Solo is pre-installed with Microsoft Security Essentials version.

The Security Essentials virus database should be kept up to date but allowing it to access the internet for updates. The Administrator should check the operation of the Security Essentials Control Panel periodically to ensure all components are updated and working correctly. This will ensure your Solo is virus free.
4.3 TeamViewer

Solo is pre-installed with TeamViewer which is a remote access application that will allow remote support from the Oracle Customer Service Team. For correct operation, Solo must be able to access the internet and the URL www.teamviewer.com must be reachable.

For remote support, please quote the session ID number displayed in the TeamViewer Control Panel to the Oracle Customer Service Team member.

4.4 UltraVNC

Solo is pre-installed with UltraVNC which is another remote access application that the Oracle Customer Service Team can use to help diagnose problems. Unlike TeamViewer, UltraVNC does not require Internet access but the use of TCP port 5900 instead. In most cases, the UltraVNC application is only used within an internal local network. For external access, TCP port 5900 must be opened and re-directed to the Solo.
4.5 FileZilla FTP Server

Solo is pre-installed with FileZilla FTP Server. The files in the folder F:\SUCCESS are available via this FTP server listening on TCP port 21. The FTP account name is “samma” and the default password is “samma” (case sensitive).

All settings have been carefully adjusted to give optimum performance for Solo. If changes to the FTP server settings are required, please contact the Oracle Customer Service Team or see www.filezilla-project.org for detailed instructions.
5 Migration Control Screen

5.1 General Layout

After starting a new XML migration window or SAMMA XML Template (SXT), the active window encapsulates a complete instance of control over all necessary hardware and associated components specified in the template. Opening another window or template that uses the same resources will fail. The SXT templates may contain hardware resources of RPCs running on remote Solos and hence the user may create new templates that can be used to control many different Solos from one master Solo’s GUI screen. Contact the Oracle Customer Service Team for more information on how to control multiple Solos from one control screen.

5.2 Source VTR remote
5.2.1  Remote LED
This LED should be green to indicate that Solo has control of the VTR.

5.2.2  Servo LED
This LED indicates the VTR has obtained servo lock from the Tape RF signal. Typically a VTR has to obtain servo lock before any valid video appears on its outputs.

5.2.3  Channel Condition LED
This LED indicates the channel condition (extended VTR status) of the tape being played. This normally applies to digital tapes only and is not available on all VTRs. The LED has 4 states. Black when there is no channel condition information available, green when it is good, yellow when it is indeterminate and red when there is an error. The channel condition state is selectable for use in the SAMMA Eye monitoring.

5.2.4  Tape Time Code
This shows the time code information from the tape. For some VTRs, if there is no time code information on the tape, it shows the internally generated time code from the VTR.

5.2.5  Mark In Time Code
This sets the start time of the tape for the migration. If enabled, Solo searches the tape for the Mark-In Time Code and if found, begins the migration at this point.

5.2.6  Mark Out Time Code
This sets the end time of the tape for the migration. If enabled, Solo will terminate the migration when the Mark-Out Time Code of the tape is reached.

5.2.7  Duration
This sets the duration time in hours, minutes and seconds for the migration. If enabled, Solo will terminate the migration when the duration time is reached.

5.2.8  Stop
This button terminates the current process of the VTR.

5.2.9  Rewind
This button rewinds the tape in the VTR.

5.2.10  Play
This button plays the tape in the VTR.

5.2.11  Fast Forward
This button fast forwards the tape in the VTR.

5.2.12  Pause
This button pauses the current process of the VTR.

5.2.13  Eject
This button ejects the tape from the VTR.
5.3 Input Analysis

5.3.1 Video Present LED
The ‘Video Present’ LED indicates valid video is detected by the Analysis Engine for the selected input source set by this template.

5.3.2 Recorded Time Code
The ‘Recorded Time Code’ indicate the actual time code embedded as VITC on all the video outputs and LTC output. This value may be from the Source VTR time code or from the internal time code generator within the Analysis Engine.

5.3.3 Level Monitors
This section monitors and visualizes the video levels for Y, Pb and Pr, Drop Out, RF and Audio levels during migration.

5.4 Migration

5.4.1 Status LED
This section displays the migrating status and video in progress. The ‘Status’ LED shows the overall migration status. If for any reason the migration is stopped prematurely, this will change to yellow for a recoverable migration, or red for a failed migration.

5.4.2 Migrate Button
The ‘Migrate’ button starts a migration. Once started, the button changes to display ‘Stop’. The user can use this button to manually terminate the migration and mark the result as successful or failed.
5.4.3 **Elapsed Time**

This displays the elapsed time for the migration in hours, minutes and seconds.

5.4.4 **Preview Window**

![Preview Window](image)

The preview window is a Windows Media Player control that shows a delayed WMV stream from the SME encoder. The preview content is delayed by approximately 10 seconds from the input video. Audio for the preview can be heard on the Solo’s rear PC audio jacks.

5.5 **Output Device – JPEG2000 MXF**

This section displays the status of the JPEG2000 MXF encoder.

5.5.1 **Status LED**

The real time cache file name is displayed and its encoding status is indicated by the LED. The LED will change to yellow for any recoverable warning or red for any non-recoverable errors.

5.5.2 **Real Time Bit Rate Calculation**

The actual file size of the primary file as it is being recorded is displayed here. The calculated bit rate at which the file is growing is also displayed. This value can be used to detect faulty encodings that do not meet the expected bit rate.

5.5.3 **Disk Space Indicators**

The top and bottom green bars shows the available disk space for the cache and success locations respectively. The red marker indicates the minimum space limit for a migration to start. This is settable from the **Configuration > Encoders** options.

5.6 **Output Device – SAMMA Multicoder**

This section displays the status of the SAMMA Multicoder (SME).
5.6.1 Status LED
The real time cache file name is displayed and its encoding status is indicated by the LED. The LED will change to yellow for any recoverable warning or red for any non-recoverable errors.

5.6.2 Real Time Bit Rate Calculation
The actual file size of the primary file as it is being recorded is displayed here. The calculated bit rate at which the file is growing is also displayed. This value can be used to detect faulty encodings that do not meet the expected bit rate.

5.6.3 Disk Space Indicators
The top and bottom green bars shows the available disk space for the cache and success locations respectively. The red marker indicates the minimum space limit for a migration to start. This is settable from the Configuration > Encoders options.

5.7 Output Device – Dub VTR
This section shows the Dub VTR.

5.7.1 VTR Controls
The controls are similar to those of the Source VTR.

5.8 Message Log
All events for the migration are logged here. This log is also included as part of the XML document.
6 SAMMAsolo Menu Options

6.1 Toolbar Menu

1. New from Template (SXT)
2. New from Database
3. Open
4. Save
5. Page Setup
6. Login
7. Logout
8. View Database
9. Options
10. Migrations Details
11. Source VTR
12. Analysis Engine
13. SAMMA Eye
14. Encoders
15. Metadata
16. Calibrate VTR
17. Data Analysis
18. Tape Details
19. Help

6.2 File

<table>
<thead>
<tr>
<th>File</th>
<th>Configuration</th>
<th>M giants</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Ctrl-N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl-O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl-F4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl-S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl-A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 Unnamed 24M.xml</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.2.1 New from Template (SXT)

This option displays the ‘SAMMA XML Template’ dialog.

The SXT Template is the baseline or starting point for every migration project. The dialog box displays the default directory which includes all default templates. Select the template and click ‘Open’ to start a new migration project.

6.2.2 New from Database

Migration template may be stored in database. Solo can pick the tape’s template by LookUp from the database or by Scan tapes’ barcode.
6.2.3 Open

This option displays the ‘SAMMA XML Files’ dialog.

This option allows the user to re-open any saved migration projects. After opening, the user may view the results or choose to re-migrate the tape using the saved settings or to start a new migration based on the saved settings.

6.2.4 Save

This option saves any pending change of the current Solo project.

6.2.5 Save As...

This option displays the ‘Save As...’ dialog.

Select the destination and filename to save the Solo project. Click ‘Save’ after completion.
6.2.6 Print Page Setup

This option displays the 'Print Page Setup' dialog.

This screen contains checkboxes where the user can set Solo to:

- Print History Log
- Print Video Y / Pb /Pr Graph
- Print Drop Out / RF Graph
- Print Input / Servo Lock Graph
- Print Audio Ch1 / Ch2 / Ch3 / Ch4 Graph
- Print Video Y / Pb /Pr Graph
- Print Graphs On New Page. Choose option 'All Graphs On One Page' or 'One Graph Per Page'
- Print footer information

6.2.7 Recent Documents

This option (located between the option 'Save As...' and 'Exit') opens any recent Solo projects listed.
6.2.8 Exit

This option will close all open windows and quit the application.

6.3 Configuration

6.3.1 Administrator

6.3.1.1 Administrator Log In

This option displays the ‘Administrator Login’ dialog. Type the password and click ‘OK’ to log in as an Administrator.

6.3.1.2 Administrator Log Out

This option logs the administrator out.

6.3.1.3 Change Password

This option displays the ‘Administrator Password’ dialog.

Type in the new password twice and click ‘OK’ to change the password.
6.3.2 Tape Database

This option views the Tape IDs Database.

The user can search, add/modify and delete tape information within the database.

The user can search tape information with the entire or part of any field displayable in the dialog. Input the keyword in the 'Search Text' area and click 'Search'. Tapes with the matching keyword will be displayed.

'Show All' displays all the tape in the database.

The user can also use the 'Import (XML)' or 'Import (CSV)' buttons to populate the database.

After each migration, Solo saves all the information of the tape in a XML project document. The user can import the tape information into the database by importing the same XML project document file with the option 'Import (XML)'.

For details of 'Import (CSV)', read section Appendix E: SAMMA CSV Import Format.

Add/Modify displays the 'Tape Detail' Dialog. (For details, read section Tape Details).
### 6.3.3 Options

**General Configuration**

**General Options**
- Automatically save XML metadata file after migration
- Sequential Post Processing for Encoders
- Default Template (.SXT) Directory: `C:\Program Files\Front Porch Digital\SAMMA\Solo`
- System Language: `English`

This option can:
- Set whether Solo prompts to save the XML project file after a migration has completed
- Set the post processing to run sequentially or in parallel
- Change the default directory for SXT templates
- Set the System Language

**Tape Database**
- IP Address: `localhost`
- Port: `5433`
- DSN: `Samma`
- Database Name: `SammaCustomer`
- Database User Name: `postgres`
- Database Password: `postgres`
Database:

- Set Tape Database connection: IP Address, Port, DSN, Name, User and Password

Analysis Plot:

- Print the ‘Data Analysis’ screen results automatically after a migration has completed, normally into a PDF file writer

6.3.3.1 Post-Migration Commands
When a migration is completed whether successfully or not, Solo can run a set of user defined command line functions. Commands entered in the 'On Success:' field will run if the migration was successful. If a migration fails, Solo will run commands entered in the 'On Failure:' field.

Some examples of useful commands are:

- Email the user when a migration needs attention, either an error or ready for next tape.
- Copy files to network drives, etc. in any combination of duplicates and destinations. For example: XML to a supervisor, XML to a database, Real Media to a logger, WM9 to a Web server, MPEG-2 to an editor, JPEG 2000 to an archive, and all files to a watch folder for a TAR utility or storage management system to back them up.
- Run a batch file application (.bat) or javascript to compare SHA-1 checksums, rename files, start a video-file-analysis utility, copy selected files to watch folders for transcoding, editing, DVD-authoring, etc.

### 6.3.3.2 Upload XML

XML file can be uploaded into the SAMMA database automatically on completion.

- Set the data block (Chunk) size for the upload process.
- Set the maximum upload time for the upload process. If an upload process exceeds the maximum upload time, an error message will be shown in the migration log.

### 6.3.3.3 Macro substitution for output XML value

Macro keywords can be used in the command line to substitute the current migration’s XML data values. The macro format is $(Root/Section/Key) for any value in the XML output file. Multiple commands can be executed in sequence by separating each command with a semi-colon.

For example:

```
"C:\Program Files\Front Porch Digital\SAMMA Solo\EMail\EMAILBAT" $(Metadata/Log/Contents)
Robot1_CPU1 "Migration Failed on Tape ID: $(Settings/Details/TapeId)"
```
This command sends an email notification of the migration’s TapeID and migration failed result. The macro $(Metadata/Log/Contents) would include the migration log as an attachment showing starting and ending times, encoder and VTR events, migration results, etc.

Alternately, the user can write a batch file to insert additional user-data into Solo’s XML output file. This can be helpful for adding data meant for a subsequent database import of Solo’s XML. For example, a mnemonic prefix code might be added to the TapeID because the user’s database started using that mnemonic when the archived tapes were originally labelled.

### 6.3.3.4 Special Macro Keywords

There are several special macro keywords that are not available from the XML data. These are:

- **$(XMLFILESIZE)**: This is replaced with the XML file size in bytes (e.g. “52346342”)
- **$(XMLSHA)**: This is replaced with the SHA-1 value of the XML file (e.g. “745634563456345673678393626267846373584645343673”)
- **$(XMLFILEDATE)**: This is replaced with the XML file date (e.g. “2009-01-27 12:30:28”)
- **$(XMLFILEDATET)**: This is replaced with the XML file date in the XML ‘T’ notation (e.g. “2009-01-27T12:30:28”)

### 6.3.4 Migration Details

This option displays the ‘Migration Details’ dialogs.

Solo automatically generates an unique ‘Barcode/UMID’ number for every migration. If desired, the user may scan a barcode from the source videotape to populate the fields on this screen or manually enter a value.

There are three buttons to the right of the ‘Barcode/UMID’ field:

- Click ‘New’ to assign a unique random Barcode/UMID number to this migration.
- Click ‘Lookup’ to learn whether this number is already in the database.
- Click ‘Scan’ to direct Solo’s optional scanner to read a barcode label.
If this is the first time that this barcode number is being entered into the system, an error message similar to the following will be displayed after you click ‘Lookup’ or complete a scan:

![Error Message]

The barcode number will be entered into the database after the completion of the current migration.

Enter the operator’s name or initials in the ‘Migrated By:’ field. This is a required field.

The user may enter a ‘Tape ID’ manually or it may be populated from Solo’s database by scanning the videotape’s barcode. This is a required field.

If the ‘Output Filename’ field is blank, then Solo uses the value in the ‘Tape ID’ field as the filename except that all spaces and invalid filename characters are replaced with an underscore character.

There are four user fields that can be customized through simple edits to Solo’s configuration file (C:\Windows\Sammasolo.ini). All four fields are text fields:

- <location>
- <author>
- <description>
- <comments>.

The ‘Passed Inspection’ (visual & smell for odors) checkbox is normally populated from Solo’s database via the tape’s barcode, or may be manually checked / unchecked. This field is set by SAMMA Prep.

‘Cleaned’, ‘Cleaning Result’ and ‘Cleaning Date’ fields are normally populated by SAMMA Robot or SAMMA Clean applications and indicates when the tape was cleaned. The user may manually set or clear these fields.

The ‘Video Standard’ field should be set to reflect the actual video standard of the tape.

The ‘Migrated’, ‘Migration Result’ and ‘Migration Date’ fields are populated by Solo when the migration completes. The user should not change these.
6.3.5 Source VTR

This option displays the 'Source VTR Configuration' dialog.

Clear the 'Enable Remote Control of VTR' if the user wants to control the source VTR using its onboard buttons, or if the video source is not a VTR or if the VTR does not support the Sony RS-422 9-pin protocol. Checking this box (which is the default) and putting the source VTR in Remote Control mode (usually via a switch), enables the following choices:

- **Rewind tape before migration** will rewind the tape to the beginning before migration begins. If cleared, the migration will begin exactly at the position of the tape in the VTR. The default is checked.
- **Wait for Servo Lock before migration** will cue the encoders and then wait for the VTR to detect servo lock before the encodings are started. An additional delay in frames may be entered to compensate for invalid time code or picture disturbance at the beginning of material. This can be useful to eliminate unwanted regions of tape before valid content is detected. The default is checked.
- **Disable VTR controls during migration** will disable all the source VTR screen controls during the migration to prevent accidental button-pushes. Clear this box if the user wants to manually end a migration.
- **Disable SAMMA Eye when using Mark-Out or Duration** will disable all SAMMA Eye processing if the Mark-Out or Time Duration options are used. Clearing this option will allow SAMMA Eye to trigger an event that may stop the migration before the mark-out position or the duration has been reached.
- **Rewind tape after migration** will rewind the tape back to the beginning after the migration completes.
- **Eject tape after migration** will eject the tape from the VTR after the migration completes.
- **Monitor channel condition** will enable monitoring of the channel condition. Disable this option for VTRs that do not support the extended status protocol.
- **Mark-In Pre-Roll** sets the number of frame pre-rolled before the Mark-In TC
- **Mark-Out Post-Roll** sets the number of frame post-rolled after the Mark-Out TC
- **Play Detect Time Out** sets the time out for the playback to start as indicated by the status of the VTR. The default value is 5 seconds.
- **Response Time Out** sets the time out for VTR response. The default value is 2000 milliseconds.
Editing the text in the ‘VTR Name’ field changes the name of the source VTR on the Tape Details screen and in Solo’s XML output file.

- ‘Device IP Address’ and ‘Port’ set to connect VTR RPC communication.
- ‘Tape Format(s)’ is the list of allowed tape format for the VTR. If the Check Tape format is checked in Robot, Solo only possess the tape with tape format from this list.

6.3.6 Analysis Engine

This option displays the ‘Analysis Engine Configuration’ dialog.

See Appendix A: SAMMAsolo Connections for a variety of ways Solo can be connected. The user’s chosen connections can be enabled, disabled and routed here. User settings should always be saved in templates (i.e., .SXT files).

There are (almost) no right or wrong settings for the Analysis Engine. Following are a few tips, but the user is encouraged to experiment with different video settings, especially with older video because production practices varied widely.
Video Options:
- Select an ‘Input’ and an ‘Input Standard’ to match Solo’s source VTR and source videotapes. Options are CVBS (Composite Video Blanking Sync), SDI (Serial Digital Interface), YC (S-Video) and ‘YPbPr’ (3-wire component) inputs. After changing the Input Standard, check SAMMA Eye (Configuration→SAMMA Eye) – in some cases the Drop Out Compensator may default to OFF.
- ‘Input YPbPr Format’ selects the Normal (SMPTE/EBU) or Sony Betacam versions of component video, which are slightly different. Choose ‘Betacam’ if the source VTR is Betacam VTR.
- ‘Input NTSC Std’ designates which version of NTSC is the standard input, ‘NTSC’ or ‘NTSC-J’.
- ‘Timecode Source’ Analysis Engine can read either ‘LTC’ (longitudinal time code) or ‘VITC’ (vertical interval time code) from the source VTR, or it can generate its own internal time code. VITC is generally more accurate than LTC but is not found on all source tapes. The factory default is LTC. If ‘TC Source’ is set to OFF, the Analysis Engine will ignore time code from the source VTR and will not feed time code to the encoders or other Solo outputs. If time code is set to ‘Internal Gen’, the Analysis Engine will generate new time code that bears no reference to time code from the source VTR. The time code source chosen here is fed to all internal encoders and to ANALOG OUT S (XLR) for use as LTC elsewhere, and is also embedded as VITC in Solo’s outputs labelled CVBS (composite), Y-Pb-Pr (component), and SDI OUT.

Audio Options:
- ‘Audio Source 1’ & ‘Audio Source 2’ select which pair of Solo’s four analog audio inputs to use. Most older videotapes are stereo so ‘Analog Pair A’ can usually be routed to ‘Group 1’. For other settings consult an expert user or the Oracle Customer Service Team as these settings must be consistently followed through with video compression encoders.

In Level:
- ‘In Level’ 18.0 dBu is the midpoint and the default. Clicking ‘R’ returns the slider to the default setting.
**Output:**

**Video Options:**
- ‘Output Format’ sets Solo’s output to YC, YPbPr (default), or RGB (in addition to the permanent Composite and SDI outputs).
- ‘Output 625 Std’ sets Solo’s standard output for 625: ‘PAL’ or ‘PAL-N’.

**Audio Options:**
- ‘Output Embedded Group’ routes analog audio inputs to SDI embedded audio output groups. Select ‘Disable’ or ‘Group 1, 2, 3, or 4’.
- ‘Audio Delay’ slider designates a constant delay between the audio and the video source. Clicking ‘R’ returns the slider to the default setting.
- ‘Out Level’ 18.0 dBu is the midpoint and the default. Clicking ‘R’ returns the slider to the default setting.

**System:**

**Decoder Options**
- ‘Genlock’ synchronizes Solo to a reference signal. Solo does not require an external genlock signal because the Analysis Engine includes a frame synchronizer, so a common setting is ‘Free run’. To sync with an external monitor (if picture rolls or is vertically offset), connect a reference sync or black CVBS signal to Solo’s Reference input (Ref In) and set Genlock to ‘Ref Lock’. ‘Input Lock’ and ‘Float’ are other synchronization modes and are NOT recommended for use.
- ‘Decoder AGC’ is Automatic Gain Control. The input video’s sync amplitude is measured and the entire signal, including active video, is increased or decreased until sync is corrected to standard levels. This setting only applies to the CVBS input.
• ‘Decoder ACC’ is Automatic Chroma Control. The input video’s color-burst is measured and the chroma signal, including active video, is increased or decreased until chroma is corrected to standard levels. This setting only applies to the CVBS input.

• ‘Decoder CTI’ is Chroma Transition Improvement, and sharpens the edges of colored objects. Setting Decoder CTI to ‘ON’ improve the sharpness of color transitions. This setting only applies to the CVBS input.

• ‘Decoder NR’ is digital noise reduction. Analog tapes, particularly U-matic and VHS, can be noisy. Removing any portion of the noise can dramatically improve the quality of video compression so the normal setting is ON. The user may insert external noise reduction equipment in the path between the source VTR and Solo and in that case, Analysis Engine’s noise reduction should be set to OFF. This setting only applies to the CVBS input.

• ‘Drop Out Comp’ can be enabled whenever a RF signal is available from the VTR and connected to the Solo. Typically, U-matic VTRs provide a RF signal that can be used for this purpose.

• ‘Comb Filter’ reduces interference between color and luminance in composite (CVBS) video. Enabling the Comb Filter reduces “hanging dots” (dot crawl) and cross-color artifacts. The normal setting is ‘ON.’ This setting only applies to the CVBS input.

Device Location:
• ‘Device Location’ IP Address and Port information is shown for reference only. These can be changed in Solo templates (.sxt) with a normal text editor. These settings should only be changed by the Oracle Customer Service Team or an expert user.

Proc Amp Controls Options:
• ‘Luma Gain’ slider controls the amount of Luma Gain in dB. Clicking ‘R’ returns the slider to the default setting.

• Black Level’ slider controls the amount of Black Level in mV. Clicking ‘R’ returns the slider to the default setting.

• ‘Chroma Gain’ slider controls the amount of Chroma Gain in dB. Clicking ‘R’ returns the slider to the default setting.

• ‘Hue’ slider controls the amount of Hue in degrees. Clicking ‘R’ returns the slider to the default setting.

When using the proc-amp controls, a waveform monitor and vectorscope are recommended to see their effects and avoid settings that are illegal (e.g., outside standard). Settings are saved in templates, which can be helpful when a collection of videotapes will benefit from consistent adjustments.

Note:
Analysis Engine settings are recorded in templates (.sxt files) and in each migration’s XML file.
6.3.7 Miscellaneous Analysis Engine Configuration

The settings available on the **Miscellaneous Analysis Engine Configuration** screen are:

**Decoder Bandwidth:**
- ‘**Full Bandwidth**’ (the default) allows the full bandwidth frequency of 5.75MHz for luminance and 2.75MHz for chrominance to pass through the decoder. This gives the best picture quality.
- ‘**Luminance Low Pass**’ filters all luminance frequencies above 3.5Mhz. This can be used to ‘soften’ the picture when the picture contains lots of high frequency noise.
- ‘**Luminance Notch**’ filters only the frequencies centered around the sub-carrier frequency of the selected video standard. This can improve cross-color or chroma noise while maintain a visually sharp picture.

**Output Options:**
- ‘**Default Output**’ selects the signal type that the Analysis Engine will output whenever there is no input to Solo as selected by ‘Input’ above, whether caused by invalid sync or none at all. A common setting is ‘Input’ so the user can see the last valid frame when the picture was lost. ‘**Color Bars**’ and ‘**Black**’ are useful for testing signal paths, “blacking” videotapes, etc.
- ‘**Test Pattern**’ can be set to ‘**Color Bars**’ or ‘**Black**’, both generated by the Analysis Engine. This is sometimes useful in testing or troubleshooting, but do not leave this option set to either color bars or black during normal operations. The default setting for this is ‘**Off**’.
- ‘**Freeze**’ pauses the current image on the screen.
- ‘**Freeze Style**’ can be set to either ‘**Field**’ or ‘**Frame**’.

**Drop Out Compensation:**
- ‘**Test View**’ can be set to Off or On. This setting displays dropouts as purple streaks at the position of the dropout for easy identification.
- ‘**Split Screen**’ can be set to Off or On. This allows the user to simultaneously see the picture with and without dropout correction.
- ‘DO Level’ slider controls the percentage of Drop Out Level. Clicking ‘R’ returns the slider to the default setting.
- ‘DO Delay’ slider controls the difference in time between the RF signal and video input seen at the Solo. For drop-out compensation to work correctly, this must be adjusted so that the visible purple streaks (in Test View mode) coincide correctly with the errors seen on screen. Clicking ‘R’ returns the slider to the default setting.

6.3.8 SAMMA Eye

This option displays the ‘SAMMA Eye Configuration’ dialog.

SAMMA Eye performs three key functions during a migration:

- Detect the end of programming and stop the migration to save time and storage.
- Monitor levels and log above-threshold excursions into the XML file.
- See potential problems in the source video and if desired, end migration as an Error.

SAMMA Eye can be used to improve the overall throughput (speed) of migrations over time. The user is encouraged to experiment with these settings and create templates. See also the chapters Getting Started with SAMMAsolo.

Video:

Video Options:

- ‘Black Threshold’ might be set soon after Input Loss to detect the end of video recording, but with an additional 10 seconds or so in case black is part of the program. 30 seconds for example. It is commonly used to detect the likely end of video content and is not usually considered an error condition. Sometimes tapes were ‘blacked’ before use and so black continues long after the program is finished. Black Threshold can also be set higher than the video standard calls for, to allow for unimportant deviations in older recordings.
- ‘Drop Out Threshold’ might be set the shortest of all to detect damaged videotape or a clogged head in the source VTR. 5 or 10 seconds for example. It applies only to VTRs with an RF signal connected to the Solo. A high number of dropouts for a long period may indicate poor condition of the videotape or a clogged head in the source VTR. Either situation could justify stopping the migration to care for the tape with SAMMA Clean, and/or service a clogged head. If the problem is a clogged head, remember to calibrate the source VTR before continuing migrations.
- ‘Input Loss Threshold’ might be set to fairly soon after Servo Lock to detect no video even if the tape is playing. 20 seconds for example.
Audio:

Audio Options:

- **Audio Threshold** might be set last to detect an audio problem when the video is okay. 40 seconds for example.

Video:

VTR Signal:

The length of each threshold’s **Duration** effectively sets its priority to function as a trigger. Shorter durations will trigger first, longer durations will trigger later. The user can create any sequence, but as an example:

- **Servo Lock Threshold** might be set to the shortest duration because without servo lock, the other Thresholds trigger anyway. 15 seconds is a good starting point.
- **RF Threshold** might be set soon after Input Loss to detect the end of video recording, but with an additional 10 seconds or so in case black is part of the program. 30 seconds for example.
- **VTR Channel Condition** is used to detect the quality of the picture reported by some VTRs. For digital tapes, this normally indicates a break-up of the picture or some sort of distortion of video or audio. The user can select either a “Warning” or “Error” level for the threshold. If the state is equal or above the threshold for the set duration, a termination of the migration will be triggered.

‘Notify As Error’ checkboxes are available for each threshold. If checked, and that threshold is exceeded for the number of seconds entered in its Duration field, an error event will be triggered to terminate the migration. If ‘Notify As Error’ is not checked, Solo will terminate the migration as a Success.

**Note:**

SAMMA Eye settings are recorded in templates, and in each migration’s XML file.
6.3.9 Encoders

This option displays the screen illustrated below.

Solo can control up to 6 different types or instances of encoders. These include Motion JPEG2000, SAMMA Multcoder and Dubbing VTR. Please contact the Oracle Customer Service Team for installation of additional encoders.

6.3.9.1 JPEG2000 MXF

Encoding Standard:
- NTSC (525 lines)
- PAL (625 lines)

Audio Channels:
- 2
- 4
Video Resolution:
- 8 bits (per channel of YUV giving 24 bits of color resolution)
- 10 bits (30 bits of color resolution)

Audio Source:
- AES connector
- Embedded Audio from SDI source

Encoding Profiles:
- Lossless (variable rate of approximate rate of ~50mbps)
- High Quality (~25mbps)
- Medium Quality (~10mbps)
- Low Quality (~5mbps)

Additional Flags (advanced settings):
- -agr n is AudioGroup where n is audio group 1 (default), 2, 3 or 4.
- -apa n is AudioPair where n is 1 (default) or 2.
- -asb n is AudioSamplingBits where n is 16 (default) or 24.
- -rc n is RateControl where n is 0 - NONE (default), 1 - SIZE, 2 – QUALITY, 3 - MULTILAYER and 4 - MULTILAYERQUALITY
- -rcv n is RateControlValue where n is a value from 0 to 65535 (default is 1280)
- -bs n is BlockSize where n is 0 – 32x32, 1 – 64x32, 2 – 64x64 (default), 3 – 128x32
- -wks n is WaveletKernelFactor where n is 0 – Irreversible9x7, 1 – Reversible5x3 (default), 2 – Irreversible5x3
- -tl n is TransformLevel where n is a value from 1 to 6. (Default is 5).
- -qf n is QuantisationFactor where n is a value from 0 to 256 (default is 0).
- -jps n is J2KProgressionStyle where n is 0 – LRCP (default), 1- RLCP, 2- RPCL, 3 – PCRL and 4 – CPRL.
- -oft n is OutputFormat where n is 0 – RAW, 1 – J2C (default), 2 – JP2.
- -plt defines the use of PLT
- -pnt defines the use of PPT
- -sop defines the use of SOP
- -epn defines the use of EPH

Record Preview:
- Allows the preview of the encoded stream in real time on Solo’s JPEG2000 SDI output

Output File Path (Cache location relative to JPEG2000 machine)
- This is the location where the real time cache file is stored.

Move file to here on successful migration (Success location):
- If selected, this will move the successfully migrated files from the ‘Output File Path’ to this new location. If a migration fails, the files are not moved and will be left in the ‘Output File Path’ for the user to inspect.

Generate SHA-1 value:
- Enabling this option will force Solo to generate the SHA-1 (digest value) checksum of the output file(s) and write it into the output XML document. This will allow the user to verify the integrity of the file after it has been moved to the user’s storage system.

Low disk space limit (MB)
- This sets the low disk space threshold for Solo to allow a migration to start on this encoder. This value should be at least bigger than the maximum file size expected for the length of encoding at the current encoder settings. When either the Output File Path or the Success location disk space is below this limit, the encoder will fail to start. If the available disk space falls below this limit during a migration, the migration will continue unless the encoded files cannot be written due to the lack of disk space.
- Set this value to 0 to disable the low disk warning.
- The default value is 50,000 MB

Notify as ERROR if bit rate is below (bit rate for duration):
- The bit rate value and the duration are used to monitor the real time encoded bit rate of the output file. For most encoder types, the files they produce grow at approximately the same rate as the video bit rate plus the audio bit rate. Solo monitors the file's rate of growth so that if the file does not grow at the expected rate, an error is produced to terminate the migration.

### 6.3.9.2 SAMMA Multicoder

![SAMMA Multicoder Configuration](image)

**Project Filename:**
- This defines the SME project associated with this template. Use the browse button to view and select a project available. The SME project must be created in advance.

**Output File Path (Cache location relative to SME machine):**
- This is the location where the real time cache files are stored.

**Primary File Extension:**
- This should contain the primary file extension that Solo should monitor for correct encoding. This is normally the highest resolution or most important file in the SME project. The bit rate monitoring option applies to this file only.
- Success sub-folder locations for different file extension can be assigned by pre-pending the sub-folder to the extension. E.g. "<IMXMXF>:imx.mxf" will move the file output.imx.mxf into the success location F:success\IMXMXF\output.imx.mxf. Please note that Solo does not create the sub-folders automatically so the user must have created them in advance.

Move file to here on successful migration (Success location):
- If selected, this will move the successfully migrated files from the 'Output File Path' to this new location. If a migration fails, the files are not moved and will be left in the 'Output File Path' for the user to inspect.
- The 'Process additional extensions' should contain a comma separated list of the file extensions that must match those used in the SME project.
- Each extension may also have a success sub-folder associated with it. E.g "<WMV>:wmv,<MOV>:mov" will move the file output.wmv into the location F:success\WMV\output.wmv and the file output.mov will be moved to location F:success\MOV\output.mov.

Generate SHA-1 value:
- Enabling this option will force Solo to generate the SHA-1 (digest value) checksum of the output file(s) and write it into the output XML document. This will allow the user to verify the integrity of the file after it has been moved to the user's storage system.

Low disk space limit (MB)
- This sets the low disk space threshold for Solo to allow a migration to start on this encoder. This value should be at least bigger than the maximum file size expected for the length of encoding at the current encoder settings. When either the Output File Path or the Success location disk space is below this limit, the encoder will fail to start. If the available disk space falls below this limit during a migration, the migration will continue unless the encoded files cannot be written due to the lack of disk space.
- Set this value to 0 to disable the low disk warning.
- The default value is 50,000 MB

Notify as ERROR if bit rate is below (bit rate for duration):
- The bit rate value and the duration are used to monitor the real time encoded bit rate of the output file. For most encoder types, the files they produce grow at approximately the same rate as the video bit rate plus the audio bit rate. Solo monitors the file's rate of growth so that if the file does not grow at the expected rate, an error is produced to terminate the migration.
Rewind tape before migration:
- Instructs the VTR to rewind the tape to the beginning before the migration starts.

Rewind tape after migration:
- Instructs the VTR to rewind the tape back to the beginning after the migration completes.

Eject tape after migration:
- Instructs the VTR to eject the tape after the migration completes.
6.3.10 Metadata

This option displays the ‘XML Metadata Configuration’ dialog.

‘Save Collected Metadata’ enable metadata saving in the XML.

‘Metadata Cache Directory’ is the location where the XML files are cached or left after a failed migration. ‘Metadata Success Directory’ is the location where the XML files are moved to after a successful migration.
Shot List:

‘Enable Shot List’ enable Shot List marking in XML for search pattern.
‘Search Pattern Attributes’ defines search pattern.
‘Tolerance Level’ is the tolerance level for the search pattern.
‘Duration Tolerance’ is the minimum duration for matched pattern.
‘Create AVID file’ enable the AVID file creation.
‘Create Final Cut Pro XML file’ enable the Final Cut Pro XML creation.

Black Detection:

‘Enable Black Detection’ enables Black Detection Marking in XML.
‘Y Level’ is the breakpoint of blackness.
‘Duration Tolerance’ is the minimum duration for Black Detection recognition.

Freeze Frame Detection:

‘Enable Freeze Frame Detection’ enables Freeze Frame Detection Marking in XML.
‘Level Tolerance’ is the breakpoint of tolerance.
‘Duration Tolerance’ is the minimum duration for Freeze Frame Detection recognition.
Audio Silence:

Enable Audio Silence detection can be set individually for each audio channel 1-4. Record is written in the XML for Audio Silence Detection on the audio channel. ‘Threshold Level’ is the breakpoint of audio silence. ‘Duration Tolerance’ set the minimum duration for silence recognition.

Audio Active:

Enable Audio Active detection can be set individually for each audio channel 1-4. Record is written in the XML for Audio Active Detection on the audio channel. ‘Threshold Level’ is the breakpoint of audio active. ‘Duration Tolerance’ set the minimum duration for audio recognition.

6.3.11 Calibrate VTR

6.3.11.1 Calibration Tape for your VTR

Before calibration can begin, obtain the correct calibration tape for your VTR type (U-matic, Betacam or VHS) from the Oracle Customer Service Team.

Your particular configuration may require checking or un-checking some of the options on this screen. For example, U-Matic tapes do not include Pb, Pr or audio channels 3 and 4.

Insert the calibration tape into the VTR and click ‘Start’ to begin VTR calibration.
6.3.1.1.2 Calibration Results

The thick green levels indicate the actual levels measured by the Analysis Engine. The thin red markers indicate the upper and lower limits of the measurement. After a few seconds, the levels will stabilize and the result will be successful if all the selected measurements are within their limits.

If the VTR calibration check returns an error message, the VTR may need cleaning or servicing. Check the cables and the VTR's adjustable settings first (in case they've been disconnected or misaligned).

The limits for each measurement parameter can be found in the sammasolo.ini configuration file. Editing the limits will allow the calibration process to increase or decrease the tolerance of the measurements. This can be useful if the VTR is old and have wide signal variations.
6.3.12 Migration

6.3.13 Start
This option starts a migration.

6.3.14 Stop
This option terminates a running migration.

6.4 View

6.4.1 Toolbar
This option toggles the visibility of the 'Toolbar'.

6.4.2 Status Bar
This option toggles the visibility of the 'Status bar'.
6.4.3 Display Styles

User can change the display style of the application with the themes illustrated below:

Windows Classic

![Windows Classic Theme](image)

Black Theme

![Black Theme](image)
Blue Theme

Silver Theme
6.4.4 Data Analysis

Solo XML files are meant to be read and processed by other computer software applications, typically following the Document Object Model (DOM) for representing XML or HTML in graphical ways. For example, JavaScript is one well-known application of the DOM method for rendering a Web page from HTML.

It is impossible to list all the possible ways that the user might use Solo’s XML metadata. This document presents the following example, which is useful for video logging, quickly seeing common videotape problems, etc.

Solo will open the currently active XML document and draw a graphical representation of the XML metadata regarding luminance and chroma levels, RF levels and dropout compensations, servo lock and audio levels. These factors are useful for seeing at a glance any periods of black or other static color that the video may have, indicating spaces between segments or slates. They are also useful for seeing where the active video ends, and possible trouble spots.

The following illustrations show several views of the same videotape, and a few ways to use these views for logging, detecting segments, detecting video problems, etc.

6.4.4.1 Screen shot of XML data graphically
Clicking the left or the right mouse buttons in the graphs will zoom-in and zoom-out the horizontal time scales respectively. Click and hold down the left mouse button and drag left or right to pan the data across the graphs. If the ‘Lock All Time Scales’ option is selected, all graphs will move and track on the horizontal time scale simultaneously.

6.4.4.2 Common Event Patterns

There are numerous information that can be deduced from the graphs but most require knowledge of the tape and video content to fully understand its meaning. There are some simple patterns in the graphs that can indicate specific content or events on the tape.

The above diagram shows a typical migration. At the beginning of the migration, arrow 1 shows that the tape content contain all 3 video components indicating the picture contains color and not just black and white. RF is good and constant showing a well recorded tape. The servo indicator is constant meaning the VTR has locked to the tape. Audio on 2 channels is varying indicating that sound is following picture content.

Arrow number 2 shows a black level of luminance and chrominance. This could be normal black content in the video but additional information from arrow 3 indicates the segment of tape had a sudden drop in RF. This indicates the recording on the tape was stopped at that point.

Arrow 4 shows that servo lock on the VTR was lost for a few seconds and then resumed. This indicates a new recording was started at this point on the tape. This is a useful indication that a segment cut point has occurred.

Arrow 5 shows a mid-level luminance bar with low levels of chrominance for some period of time. This normally indicates a test slate or color bars at the beginning of a segment. This is re-confirmed by arrow 6 which indicates a high constant audio level, typically a 1KHz tone at 0dB level.
If later analysis determines that a videotape should be migrated again with different settings or with a different template (.sxt), or perhaps collected for special processing, the name of its XML file matches the filenames of all the related digital video files, e.g., for purging or quarantine. Solo’s XML output file also contains all the video filenames and their locations, as well as the barcode and Tape ID of the source videotape, to help the user locate it in the library.

The previous illustrations show only a few basic ways to use Solo’s XML output files. There is no limit to how Solo’s metadata can be helpful, and one key is to get to know the patterns in the video programming in any given collection.

Video production methods vary widely but collections often exhibit the habits of the production teams and environments that made them. Solo’s XML output files and any DOM programmer can make these visible. Perhaps most importantly, when a pattern is discovered, the user may have already migrated many videotapes, perhaps hundreds or thousands of them. By searching the XML the user can determine which of the already-migrated videotapes follow the detected pattern.

The possibilities are endless and may continue to appear even years after a collection has been migrated.

6.4.5  Tape Details

This option displays the ‘Add/Modify Tape ID’ dialog.

All of the fields on the top half of this screen are editable except the ‘Barcode’ field. The ‘Passed Inspection’, ‘Cleaned’ and ‘Migrated’ checkboxes can be selected or unselected, but the contents of their associated fields cannot be changed.
6.5 Windows

6.5.1 Cascade
This option rearranges all windows currently open in the application into standard Windows cascade display.

6.5.2 Tile
This option tiles all windows currently open in the application.

6.5.3 Arrange Icons
This option rearranges the icons for all iconized windows currently open in the application.

6.5.4 Close All
This option terminates all windows currently open in the application.

6.5.5 Opened Document List

Select a Solo migration document currently open to bring to the front of all other document in the application.
6.6 Help

6.6.1 About SAMMAsolo

This option displays the 'About Box' for SAMMAsolo.

![About SAMMAsolo dialog box](image)
Appendix

Appendix A: Solo Connections

Back Panel of SAMMAsolo
### Solo connections: Standalone, no external monitoring, no Dub VTR

<table>
<thead>
<tr>
<th>Solo Connector, Name and Type</th>
<th>Connects To</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 1 (XLR F)</td>
<td>Source VTR, audio out 1 or L</td>
</tr>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source VTR, time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Source VTR, audio out 1 or L</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Source VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Source VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td>Source VTR, time code out</td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>Optional, User-supplied reference signal</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td>Source VTR, audio out 1 or L</td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Source VTR, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source VTR, component Y out (preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source VTR, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source VTR, component Pr out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source VTR, time code out</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source VTR, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td>Source VTR, audio out 1 or L</td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td>Source VTR, audio out 3</td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td>Source VTR, audio out 4</td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td>Source and Dub VTR RS422 connectors</td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

---

6 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback.

7 This is the same signal that is fed to all encoders.

8 RS422 breakout cables are numbered. #1 is for Source VTR, #2 is for a Dub VTR.
### Solo connections: Standalone with Dub VTR, no external monitoring

<table>
<thead>
<tr>
<th><strong>Solo Connector, Name and Type</strong></th>
<th><strong>Connects To</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 1 (XLR F)</td>
<td>Source VTR, audio out 1 or L</td>
</tr>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source VTR, time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Dub VTR, audio in 1 or L</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Dub VTR, audio in 2 or R</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Dub VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Dub VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td>Dub VTR, time code in</td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>User-supplied reference signal, or any composite or Y video from Source VTR</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Only for VHS/Hi8: Source VTR, S-Video out</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source VTR, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source VTR, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source VTR, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source VTR, component Pr out (preferred)</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source VTR, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td>Dub VTR, composite in (not preferred)</td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td>Dub VTR, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td>Dub VTR, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td>Dub VTR, component Pr out (preferred)</td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>Source and Dub VTR RS422 connectors</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

---

9. Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback
10. This is the same signal that is fed to all encoders.
11. RS422 breakout cables are numbered. #1 is for Source VTR, #2 is for a Dub VTR.
Solo connections: Standalone with external monitoring, no Dub VTR

<table>
<thead>
<tr>
<th>SOURCE VTR CONNECTOR, NAME AND TYPE</th>
<th>CONNECTS TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video output, typically Monitor (w time code)</td>
<td>Video monitor #1, or Input #1 (if 2-inputs)</td>
</tr>
<tr>
<td>Audio outputs</td>
<td>Optional, Sound system, audio inputs (VTR)</td>
</tr>
</tbody>
</table>

**SOLO CONNECTOR, NAME AND TYPE**

| AUDIO IN 1 (XLR F)                                                    | Source VTR, audio in 1 or L                     |
|AUDIO IN 2 (XLR F)                                                    | Source VTR, audio in 2 or R                     |
|AUDIO IN 3 (XLR F)                                                    | Optional, Source VTR, audio out 3              |
|AUDIO IN 4 (XLR F)                                                    | Optional, Source VTR, audio out 4              |
|AUDIO IN 5 (TIME CODE IN, XLR F)                                      | Optional, Source VTR, time code out            |
|AUDIO OUT 1 (XLR M)                                                   | Sound system, audio in 1 or L (Solo audio)     |
|AUDIO OUT 2 (XLR M)                                                   | Sound system, audio in 2 or R (Solo audio)     |
|AUDIO OUT 3 (XLR M)                                                   | Optional, Sound system, audio in 3 (Solo)      |
|AUDIO OUT 4 (XLR M)                                                   | Optional, Sound system, audio in 4 (Solo)      |
|AUDIO OUT 5 (TIME CODE OUT, XLR M)                                    |                                                  |
|REF IN (BNC)                                                           | Optional, User-supplied reference signal        |
|JPEG AUDIO OUT (SAMMA cable / XLRs)                                   | Optional, AES audio monitor                     |
|JPEG SDI OUT (BNC w/ embedded audio)                                  | Optional, SDI video monitor                     |
|S-VIDEO IN                                                             | Only for VHS/Hi8: Source VTR, S-Video out       |
|CVBS A IN (BNC)                                                       | Source VTR, composite out (not preferred)      |
|CVBS B/Y IN (BNC)                                                     | Source VTR, component Y out (preferred)        |
|Pb IN (BNC)                                                           | Source VTR, component Pb out (preferred)       |
|Pr IN (BNC)                                                           | Source VTR, component Pr out (preferred)       |
|RF IN (BNC)                                                            | For U-matic: Source VTR, RF out                |
|CVBS OUT (BNC)                                                        | Video monitor #2, or Input #2 (if 2-inputs)     |
|Y OUT (BNC)                                                           | Optional, if video monitor has a Y input       |
|Pb OUT (BNC)                                                          | Optional, if video monitor has a Pb input      |
|Pr OUT (BNC)                                                          | Optional, if video monitor has a Pr input      |
|SDI OUT (BNC w/ embedded audio)                                       | Optional, SDI A/V monitors                     |
|RS422 (9 pin SAMMA-supplied cable set)                                | Source and Dub VTR RS422 connectors            |
|GbE Ethernet x 2 (RJ45)                                               | User-supplied network                          |
|USB x 4                                                               | SAMMA barcode scanner option                   |
|PS/2 x 2                                                             | SAMMA keyboard and mouse                       |
|Windows audio out (3.5mm headphone jack)                              | User-supplied headphones or sound system       |

Solo connections: Standalone with external monitoring and Dub VTR

<table>
<thead>
<tr>
<th>SOURCE VTR CONNECTOR, NAME AND TYPE</th>
<th>CONNECTS TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video output, typically Monitor (w time code)</td>
<td>Video monitor #1, or Input #1 (if 2-inputs)</td>
</tr>
<tr>
<td>Audio outputs</td>
<td>Optional, Sound system, audio inputs (VTR)</td>
</tr>
</tbody>
</table>

---

12 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback is that same signal that is fed to all encoders.

13 This is the same signal that is fed to all encoders.
<table>
<thead>
<tr>
<th>Video output, typically Monitor (w time code)</th>
<th>Video monitor #1, or Input #1 (if 2-inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio outputs</td>
<td>Optional, Sound system, audio inputs (VTR)</td>
</tr>
</tbody>
</table>

**SOLO CONNECTOR, NAME AND TYPE**

<table>
<thead>
<tr>
<th>AUDIO IN 1 (XLR F)</th>
<th>Source VTR, audio out 1 or L</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source VTR, time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Dub VTR, audio in 1 or L (Solo audio)</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Dub VTR, audio in 2 or R (Solo audio)</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Dub VTR, audio in 3 (Solo)</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Dub VTR, audio in 4 (Solo)</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td>Dub VTR, time code in</td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>User-supplied reference signal, or any composite or Y video from Source VTR</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td>Optional, AES audio monitor</td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI video monitor</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Only for VHS/Hi8: Source VTR, S-Video out</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source VTR, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source VTR, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source VTR, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source VTR, component Pr out (preferred)</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source VTR, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td>Dub VTR, composite in (not preferred), or Video monitor #2 / Input #2 (if 2-inputs)</td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td>Dub VTR Y input (preferred)</td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td>Dub VTR Pb input (preferred)</td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td>Dub VTR Pr input (preferred)</td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI A/V monitors</td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>Source and Dub VTR RS422 connectors</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

**Solo connections: Routed Source(s), no external monitoring, no Dub VTR**

**SOLO CONNECTOR, NAME AND TYPE**

<table>
<thead>
<tr>
<th>Video output, typically Monitor (w time code)</th>
<th>Video monitor #1, or Input #1 (if 2-inputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio outputs</td>
<td>Optional, Sound system, audio inputs (VTR)</td>
</tr>
</tbody>
</table>

**CONNECTS TO**

<table>
<thead>
<tr>
<th>AUDIO IN 1 (XLR F)</th>
<th>Source VTR, audio out 1 or L</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source VTR, audio out 2 or R</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source VTR, audio out 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source VTR, audio out 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source VTR, time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Dub VTR, audio in 1 or L (Solo audio)</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Dub VTR, audio in 2 or R (Solo audio)</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Dub VTR, audio in 3 (Solo)</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Dub VTR, audio in 4 (Solo)</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td>Dub VTR, time code in</td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>User-supplied reference signal, or any composite or Y video from Source VTR</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td>Optional, AES audio monitor</td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI video monitor</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Only for VHS/Hi8: Source VTR, S-Video out</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source VTR, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source VTR, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source VTR, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source VTR, component Pr out (preferred)</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source VTR, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td>Dub VTR, composite in (not preferred), or Video monitor #2 / Input #2 (if 2-inputs)</td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td>Dub VTR Y input (preferred)</td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td>Dub VTR Pb input (preferred)</td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td>Dub VTR Pr input (preferred)</td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI A/V monitors</td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>Source and Dub VTR RS422 connectors</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

---

14 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback
<table>
<thead>
<tr>
<th>AUDIO IN 1 (XLR F)</th>
<th>Source router audio out for Channel 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source router audio out for Channel 2</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source router audio out for Ch 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source router audio out for Ch 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source router time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Source router audio out for Channel 1</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Source router audio out for Channel 2</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Source router audio out for Ch 3</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Source router audio out for Ch 4</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td></td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>User-supplied reference signal</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td></td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td></td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Only for VHS/Hi8: Source router, S-Video out</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source router, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source router, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source router, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source router, component Pr out (preferred)</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source router, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td></td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>Source RS422 port or router</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

Solo connections: Routed Source(s) and Destination(s), no external monitoring

<table>
<thead>
<tr>
<th>SOLO CONNECTOR, NAME AND TYPE</th>
<th>CONNECTS TO</th>
</tr>
</thead>
</table>

---

15 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback.
16 RF routers are uncommon so the user may substitute a direct cable or patch.
17 This is the same signal that is fed to all encoders.
18 RS422 breakout cables are numbered. #1 is for Source VTR, #2 is for a Dub VTR.
<table>
<thead>
<tr>
<th><strong>AUDIO IN 1 (XLR F)</strong></th>
<th>Source router audio out for Channel 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AUDIO IN 2 (XLR F)</strong></td>
<td>Source router audio out for Channel 2</td>
</tr>
<tr>
<td><strong>AUDIO IN 3 (XLR F)</strong></td>
<td>Optional, Source router audio out for Ch 3</td>
</tr>
<tr>
<td><strong>AUDIO IN 4 (XLR F)</strong></td>
<td>Optional, Source router audio out for Ch 4</td>
</tr>
<tr>
<td><strong>AUDIO IN 5 (TIME CODE IN, XLR F)</strong></td>
<td>Optional, Source router time code out</td>
</tr>
<tr>
<td><strong>AUDIO OUT 1 (XLR M)</strong></td>
<td>Destination router, audio in for Channel 1</td>
</tr>
<tr>
<td><strong>AUDIO OUT 2 (XLR M)</strong></td>
<td>Destination router, audio in for Channel 2</td>
</tr>
<tr>
<td><strong>AUDIO OUT 3 (XLR M)</strong></td>
<td>Optional, Destination router, audio in for Ch 3</td>
</tr>
<tr>
<td><strong>AUDIO OUT 4 (XLR M)</strong></td>
<td>Optional, Destination router, audio in for Ch 4</td>
</tr>
<tr>
<td><strong>AUDIO OUT 5 (TIME CODE OUT, XLR M)</strong></td>
<td>Destination router, time code in</td>
</tr>
<tr>
<td><strong>REF IN (BNC)</strong></td>
<td>User-supplied reference signal</td>
</tr>
<tr>
<td><strong>JPEG AUDIO OUT (SAMMA cable / XLRs)</strong></td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td><strong>JPEG SDI OUT (BNC w/ embedded audio)</strong></td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td><strong>S-VIDEO IN</strong></td>
<td>Only for VHS/Hi8: Source router, S-Video output</td>
</tr>
<tr>
<td><strong>CVBS A IN (BNC)</strong></td>
<td>Source router, composite out (not preferred)</td>
</tr>
<tr>
<td><strong>CVBS B/Y IN (BNC)</strong></td>
<td>Source router, component Y out (preferred)</td>
</tr>
<tr>
<td><strong>Pb IN (BNC)</strong></td>
<td>Source router, component Pb out (preferred)</td>
</tr>
<tr>
<td><strong>Pr IN (BNC)</strong></td>
<td>Source router, component Pr out (preferred)</td>
</tr>
<tr>
<td><strong>RF IN (BNC)</strong></td>
<td>For U-matic: Source router, RF output</td>
</tr>
<tr>
<td><strong>CVBS OUT (BNC)</strong></td>
<td>Destination router, composite in (not preferred)</td>
</tr>
<tr>
<td><strong>Y OUT (BNC)</strong></td>
<td>Destination router, Y in (preferred)</td>
</tr>
<tr>
<td><strong>Pb OUT (BNC)</strong></td>
<td>Destination router, Pb in (preferred)</td>
</tr>
<tr>
<td><strong>Pr OUT (BNC)</strong></td>
<td>Destination router, Pr in (preferred)</td>
</tr>
<tr>
<td><strong>SDI OUT (BNC w/ embedded audio)</strong></td>
<td>(do not use for Dub VTR, this is unprocessed)</td>
</tr>
<tr>
<td><strong>RS422 (9 pin SAMMA-supplied cable set)</strong></td>
<td>Source and Destination RS422 ports or router</td>
</tr>
<tr>
<td><strong>GbE Ethernet x 2 (RJ45)</strong></td>
<td>User-supplied network</td>
</tr>
<tr>
<td><strong>USB x 4</strong></td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td><strong>PS/2 x 2</strong></td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td><strong>Windows audio out (3.5mm headphone jack)</strong></td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

**Solo connections: Routed Source(s) and Destination(s), local external monitors**

<table>
<thead>
<tr>
<th><strong>SOURCE SIGNAL, NAME AND TYPE</strong></th>
<th><strong>CONNECTS TO</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Source router composite video output</td>
<td>Video monitor #1, or Input #1 (if 2-inputs)</td>
</tr>
<tr>
<td>Source router audio outputs</td>
<td>Optional, Sound system, audio inputs (Source)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>SOLO CONNECTOR, NAME AND TYPE</strong></th>
<th><strong>CONNECTS TO</strong></th>
</tr>
</thead>
</table>

---

19 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback.
20 RF routers are uncommon so the user may substitute a direct cable or patch.
21 This is the same signal that is fed to all encoders.
22 RS422 breakout cables are numbered. #1 is for Source VTR, #2 is for a Dub VTR.
<table>
<thead>
<tr>
<th>Input/Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 1 (XLR F)</td>
<td>Source router audio out for Channel 1</td>
</tr>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td>Source router audio out for Channel 2</td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td>Optional, Source router audio out for Ch 3</td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td>Optional, Source router audio out for Ch 4</td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td>Optional, Source router time code out</td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td>Destination router, audio out for Channel 1</td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td>Destination router, audio out for Channel 2</td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td>Optional, Destination router, audio out for Ch 3</td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td>Optional, Destination router, audio out for Ch 4</td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td>Destination router, time code in</td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td>User-supplied reference signal</td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td>Optional, AES audio monitor</td>
</tr>
<tr>
<td>JPEG SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI video monitor</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>Only for VHS/Hi8: Source router, S-Video out</td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td>Source router, composite out (not preferred)</td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td>Source router, component Y out (preferred)</td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td>Source router, component Pb out (preferred)</td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td>Source router, component Pr out (preferred)</td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td>For U-matic: Source VTR, RF out</td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td>Destination router, composite in (not preferred) or Video monitor #2 / Input #2 (if 2-inputs)</td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td>Destination router, Y in (preferred)</td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td>Destination router, Pb in (preferred)</td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td>Destination router, Pr in (preferred)</td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td>Optional, SDI A/V monitors (unprocessed)</td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td>Source and Destination RS422 ports or router</td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td>User-supplied network</td>
</tr>
<tr>
<td>USB x 4</td>
<td>SAMMA barcode scanner option</td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td>SAMMA keyboard and mouse</td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td>User-supplied headphones or sound system</td>
</tr>
</tbody>
</table>

**Solo connections: Routed Source(s), external encoder(s) and monitoring**

<table>
<thead>
<tr>
<th>Source Signal, Name and Type</th>
<th>Connects To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source router composite video output</td>
<td>Monitor (user-supplied or SAMMA option)</td>
</tr>
<tr>
<td>Source router audio outputs</td>
<td>User-supplied sound system</td>
</tr>
</tbody>
</table>

---

**Note:** Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback.
| Source router audio out for Channel 1 | AUDIO IN 1 (XLR F) |
| Source router audio out for Channel 2 | AUDIO IN 2 (XLR F) |
| Optional, Source router audio out for Ch 3 | AUDIO IN 3 (XLR F) |
| Optional, Source router audio out for Ch 4 | AUDIO IN 4 (XLR F) |
| Optional, Source router time code out | AUDIO IN 5 (TIME CODE IN, XLR F) |
| Destination router, audio in for Channel 1 | AUDIO OUT 1 (XLR M) |
| Destination router, audio in for Channel 2 | AUDIO OUT 2 (XLR M) |
| Optional, Destination router, audio in for Ch 3 | AUDIO OUT 3 (XLR M) |
| Optional, Destination router, audio in for Ch 4 | AUDIO OUT 4 (XLR M) |
| Destination router, time code in | AUDIO OUT 5 (TIME CODE OUT, XLR M) |
| User-supplied reference signal | REF IN (BNC) |
| Optional, AES audio router | JPEG AUDIO OUT (SAMMA cable / XLRs) |
| Optional, SDI video router | JPEG SDI OUT (BNC w/ embedded audio) |
| Only for VHS/Hi8: Source router, S-Video out | S-VIDEO IN |
| Source router, composite out (not preferred) | CVBS A IN (BNC) |
| Source router, component Y out (preferred) | CVBS B/Y IN (BNC) |
| Source router, component Pb out (preferred) | Pb IN (BNC) |
| Source router, component Pr out (preferred) | Pr IN (BNC) |
| For U-matic: Source VTR, RF out | RF IN (BNC) |
| Destination router, composite in | CVBS OUT (BNC) |
| Optional, Destination router, Y in | Y OUT (BNC) |
| Optional, Destination router, Pb in | Pb OUT (BNC) |
| Optional, Destination router, Pr in | Pr OUT (BNC) |
| SDI router in (post-TBC, pre-SAMMA Eye) | SDI OUT (BNC w/ embedded audio) |
| Source and Destination RS422 ports or router | RS422 (9 pin SAMMA-supplied cable set) |
| User-supplied network | GbE Ethernet x 2 (RJ45) |
| SAMMA barcode scanner option | USB x 4 |
| SAMMA keyboard and mouse | PS/2 x 2 |
| User-supplied headphones or sound system | Windows audio out (3.5mm headphone jack) |

**Solo connections: User Notes**

| Source signal, name and type | Connects To |
| Source router composite video output | |
| Source router audio outputs | |

| Solo connector, name and type | Connects To |
| Windows audio out (3.5mm headphone jack) | |

24 Same SDI as fed to JPEG 2000 encoder if ‘Record Preview’ enabled. Otherwise MXF file playback.
<table>
<thead>
<tr>
<th>Input/Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIO IN 1 (XLR F)</td>
<td></td>
</tr>
<tr>
<td>AUDIO IN 2 (XLR F)</td>
<td></td>
</tr>
<tr>
<td>AUDIO IN 3 (XLR F)</td>
<td></td>
</tr>
<tr>
<td>AUDIO IN 4 (XLR F)</td>
<td></td>
</tr>
<tr>
<td>AUDIO IN 5 (TIME CODE IN, XLR F)</td>
<td></td>
</tr>
<tr>
<td>AUDIO OUT 1 (XLR M)</td>
<td></td>
</tr>
<tr>
<td>AUDIO OUT 2 (XLR M)</td>
<td></td>
</tr>
<tr>
<td>AUDIO OUT 3 (XLR M)</td>
<td></td>
</tr>
<tr>
<td>AUDIO OUT 4 (XLR M)</td>
<td></td>
</tr>
<tr>
<td>AUDIO OUT 5 (TIME CODE OUT, XLR M)</td>
<td></td>
</tr>
<tr>
<td>REF IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>JPEG AUDIO OUT (SAMMA cable / XLRs)</td>
<td></td>
</tr>
<tr>
<td>jpeg SDI OUT (BNC w/ embedded audio)</td>
<td></td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td></td>
</tr>
<tr>
<td>CVBS A IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>CVBS B/Y IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pb IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pr IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>RF IN (BNC)</td>
<td></td>
</tr>
<tr>
<td>CVBS OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Y OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pb OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>Pr OUT (BNC)</td>
<td></td>
</tr>
<tr>
<td>SDI OUT (BNC w/ embedded audio)</td>
<td></td>
</tr>
<tr>
<td>RS422 (9 pin SAMMA-supplied cable set)</td>
<td></td>
</tr>
<tr>
<td>GbE Ethernet x 2 (RJ45)</td>
<td></td>
</tr>
<tr>
<td>USB x 4</td>
<td></td>
</tr>
<tr>
<td>PS/2 x 2</td>
<td></td>
</tr>
<tr>
<td>Windows audio out (3.5mm headphone jack)</td>
<td></td>
</tr>
</tbody>
</table>

---

25. Same SDI as fed to JPEG 2000 encoder if 'Record Preview' enabled. Otherwise MXF file playback.

26. RS422 breakout cables are numbered. #1 is for Source VTR, #2 is for a Dub VTR.
Appendix B: Encoder Configuration

SAMMA solo can use either internal or external encoders. Current optional internal encoders include:

- SAMMA Multicoder
- SAMMA JPEG 2000

Previous versions of SAMMA solo included the following optional encoders:

- Vela MPEG2 / Windows Media 9 / Real Media
- Vitec H.264 Transport Stream only
- SAMMA JPEG2000

Contact the Oracle Customer Service Team for more information on setting up encoders.
Appendix C: XML from SAMMAsolo Annotated

XML created by SAMMA Solo during a videotape migration, annotated for training purposes.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
This xml file's standard self-identification line.
<SammaSolo>
Device header opening this xml file.
  <Settings>
Header opening this section about this Solo's configuration and settings.
    <General>
Header opening this section about general system settings.
      <Version>2.1.0.0</Version>
This Solo's software version.
      <UserName>SammSolo3</UserName>
Name of this Solo for networking.
      <XmlPath>f:\cache\xmlfiles</XmlPath>
Interim directory for this Solo's xml files during migration.
      <XmlSuccessPath>f:\success</XmlSuccessPath>
Directory where this xml file was saved, at the completion of this videotape's successful migration.
      <Template>SammaSolo_NTSC.sxt</Template>
Template user-selected to configure this Solo for this migration.
    </General>
Footer closing this section on general system settings.
  <Details>
Header opening this section about data captured in this Solo's Tape Details screen.
    <TapeId>654.560.784.03.10</TapeId>
This videotape's catalog number, matching the tape's label and this User's tape library management database. This number was imported to the SAMMA SQL database prior to this migration, and associated to this videotape by scanning its barcode label with the handheld scanner attached to Solo.
    <Filename>654.560.784.03.10</Filename>
Filename for all files created by this migration. Files are further identified by their extensions, e.g., .mxf, .mpg, .xml, .wmv, .rm etc. By default, Solo fills this field with the TapeID data from the previous field. The User may change it.
      <BarCode>000000000000000000000000000000000000000049E44AE20000270300006A5C2</BarCode>
Samma barcode number scanned from this videotape. In this case, this barcode number is a unique number generated by a Samma Prep accessioning workstation in SMPTE's UMID format and printed on a barcode label affixed to the videotape. If this tape had not been scanned, then this number would have been a unique number generated by this Solo in SMPTE's UMID format.
    <Description>Ferris,Millicent</Description>
Title or description of this video (an interview), mapped by Oracle from the "PersonalName" field in this User's library management database.
    <Author>2005 Mar. 25.</Author>
Mapped from a field named "InclusiveDates" in this User's existing library management database. This field is normally named "Author" to prompt a user to enter the name of the video's author or copyright owner. If desired, this field could have been renamed by modifying this Solo's Windows XP .ini file.
    <MigratedBy>MSD</MigratedBy>
Initials of this migration's user.
    <MigrationDateTime>2007-12-18 17:56:48</MigrationDateTime>
Time of migration, from this Solo's system clock.
    <Comments>Inspected by jheritage</Comments>
Accessioning user for this videotape.
    <Cleaned>1</Cleaned>
Indicates whether this videotape was cleaned in a Samma Clean. Value=1 means this radio button was checked, i.e., yes. Value=0 means this radio button was not checked, i.e., no. In Solo this field is
populated by CSV import prior to migration, or by the user during migration. In a SAMMA Robot containing an internal Cleaner this field is populated by the Robot software.

<Location></Location>

Location field in the Tape Details screen. No value means this field was left blank. This field may be populated by import to the Samma SQL database from an external process such as the Samma PrepCart.

<TapIdSequence>5 of 9</TapIdSequence>

Tape ID Sequence entered during accessioning, corresponding to the last four digits of TapeID and Filename.

<Migrated>1</Migrated>

Indicates whether files were copied from the F:\cache to the F:\Success directory; logically related to the next field, MigrationResult. Value=1 means yes. Value=0 means no.

<Migrated>1</Migrated>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

Indicates the Result of cleaning the videotape, if for example the SAMMA Clean failed the tape and reported a specific error. In Solo, this field is entered by the migration user if desired, reading the Cleaner's error message from its LCD screen. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult>SUCCESS</MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.

<Migrated>1</Migrated>

<MigrationResult> SUCCESS </MigrationResult>

This migration's result. Valid values are "SUCCESS" and "FAIL."

<CleanedResult></CleanedResult>

<PassedInspection>1</PassedInspection>

<Video Standard>NTSC</Video Standard>

<CleanedDateTime></CleanedDateTime>

Indicates whether the migration user checked the radio box to verify this videotape passed a visual inspection. Value=1 means yes. Value=0 means no. This field may be populated by import to the SAMMA SQL database from an external process such as the SAMMA PrepCart.
Setting whether or not to calculate migration start and end times from the MarkOutTime and Duration fields. Value=1 means yes. Value=0 means no.

<UseMarkOutDurationOnly>0</UseMarkOutDurationOnly>

Setting, the MarkInTime for this migration. Value is in SMPTE time code.

<MarkInTime>00:00:00:00</MarkInTime>

Setting, the MarkOutTime for this migration. Value is in SMPTE time code.

<MarkOutTime>00:00:00:00</MarkOutTime>

Setting, whether or not to use the MarkInTime as the first video frame of this migration. Value=1 means yes. Value=0 means no.

<EnableMarkIn>0</EnableMarkIn>

Setting, whether or not to use the MarkOutTime as the first video frame of this migration. Value=1 means yes. Value=0 means no.

<EnableMarkOut>0</EnableMarkOut>

A duration value for this Solo to use in calculations with other fields. Value is in hours:minutes:seconds.

<DurationTime>00:00:00</DurationTime>

Setting, whether or not to use the Duration value in calculations of this migration’s start and/or end time. Value=1 means yes. Value=0 means no.

<EnableDuration>0</EnableDuration>

Identifier for the VTR used in this migration. Default value should match MigrationDevices above.

>UserTitle>VTR3_BVW-65_SN13917</UserTitle>

<EnableVtrControl>1</EnableVtrControl>

<WaitServoLockBeforeMigration>1</WaitServoLockBeforeMigration>

Footer closing this section about the Source VTR used in this migration.

</SourceVtr>

Header opening this section about the Samma Analysis Engine inside Solo (called SourceTbc here), indicating how the device was set up by the administrator before this migration. The fields below correspond to the Samma Analysis Engine’s setup screen, and are not meant to be changed by a migration user. Some fields are logically linked to this Solo’s particular hardware and wiring, and probably meant to remain consistent with variables and thresholds set by a Samma administrator for an entire library of migrations. These fields can be used by an experienced Samma administrator in forensic investigations. Samma cannot predict all the possible ways they might be used by a Samma owner.

_DeviceIPAddress=localhost
_DeviceIPPort=8003
_Input>YPbPr</Input>
_InputStd>NTSC</InputStd>
_InStdNtsc>NTSC</InStdNtsc>
_Genlock>REF LOCK</Genlock>
_Pattern>OFF</Pattern>
_DefaultOut>INPUT</DefaultOut>
_ComFilter>ON</CombFilter>
_DecoderAGC>Off</DecoderAGC>
_DecoderACC>Off</DecoderACC>
_DecoderCTI>Off</DecoderCTI>
_DecoderNR>On</DecoderNR>
<AudioSource1> Analog Pair A</AudioSource1>
<AudioSource2> Analog Pair B</AudioSource2>
_EmbedderGroup> Group 1</EmbedderGroup>
_TCSOURCE>LTC</TCSOURCE>
_LumaGain>0.0</LumaGain>
_BlackLevel>0.0</BlackLevel>
_CromaGain>0.0</CromaGain>
_Hue>0</Hue>
<YPbPrFormat>Betacam</YPbPrFormat>
Footer closing this section about the Samma Analysis Engine setup used in this migration.

<SourceTbc>

Header opening this section about the SAMMA Eye portion of the Samma Analysis Engine inside Solo, indicating how the SAMMA Eye was set up by an administrator before this migration. The SAMMA Eye is primarily used to detect user-chosen variables and thresholds in video and audio content. The fields below correspond to the SAMMA Eye setup screen, and are not meant to be changed by a migration user since they are probably meant to remain consistent with variables and thresholds set by a Samma administrator for an entire library of migrations. These fields can be used by an experienced Samma administrator in forensic investigations. Samma cannot predict all the possible ways they might be used by a Samma owner.

EnableBlackThreshold>0</EnableBlackThreshold>
BlackThreshold>10</BlackThreshold>
BlackDuration>30</BlackDuration>
EnableDropOutThreshold>0</EnableDropOutThreshold>
DropOutThreshold>50</DropOutThreshold>
DropOutDuration>30</DropOutDuration>
EnableRfThreshold>0</EnableRfThreshold>
RfThreshold>50</RfThreshold>
RfDuration>220</RfDuration>
EnableAudioThreshold>0</EnableAudioThreshold>
AudioThreshold>-60</AudioThreshold>
AudioDuration>30</AudioDuration>
EnableInputThreshold>1</EnableInputThreshold>
InputDuration>200</InputDuration>
EnableServoThreshold>1</EnableServoThreshold>
ServoDuration>30</ServoDuration>
BlackThresholdAsError>0</BlackThresholdAsError>
AudioThresholdAsError>0</AudioThresholdAsError>
DropOutThresholdAsError>0</DropOutThresholdAsError>
RfThresholdAsError>0</RfThresholdAsError>
InputThresholdAsError>0</InputThresholdAsError>
ServoThresholdAsError>0</ServoThresholdAsError>

Footer closing this section about the SAMMA Eye settings used in this migration.

<Encoder1>

Header opening this section about this Solo's first output. In the next field this output is identified as a...
VTR, not necessarily an encoder as might be implied from the title of this section. Other outputs below are video encoders.

<Type>TYPE_VTR</Type>

**Identifies this output as a VTR, called a Dub VTR on Solo’s screen.**

섣<DeviceIPAddress>localhost</DeviceIPAddress>

**Identifies this Solo as the controller of this external Dub VTR.**

<DeviceIPPort>8012</DeviceIPPort>

**IP port used to control this Dub VTR.**

<RelativeTo>Dub VTR</RelativeTo

**User’s name for this Dub VTR.**

<RewindBeforeMigration>0</RewindBeforeMigration>

Setting, whether or not to rewind the Dub VTR tape at the beginning of this migration. Value=1 means yes. Value=0 means no.

<RewindAfterMigration>0</RewindAfterMigration>

Setting, whether or not to rewind the Dub VTR tape at the end of this migration. Value=1 means yes. Value=0 means no.

<VerifyAfterMigration>0</VerifyAfterMigration>

Setting, whether or not the user acknowledged performing a manual verification of the Dub VTR tape at the end of this migration. Value=1 means yes. Value=0 means no.

<Enable>0</Enable>

Setting, whether or not to include the Dub VTR in this migration. Value=1 means yes. Value=0 means no.

<StopOnError>1</StopOnError>

Setting, whether or not to stop this migration if this Solo detects an error condition in this Dub VTR. Value=1 means yes. Value=0 means no.

</Encoder1>

Footer closing this section about this Solo’s first output.

<Encoder2>

Header opening this section about this Solo’s second output. In the next field this output is identified as a JPEG 2000 encoder.

<Type>TYPE_JPEG 2000</Type>

Header opening this section about this Solo’s second output, indicating how this encoder was set up by an administrator before this migration. The fields below correspond to the Samma JPEG 2000 encoder’s setup screen, and are not meant to be changed by a migration user since they are probably meant to remain consistent with variables and thresholds set by a Samma administrator for an entire library of migrations. These fields can be used by an experienced Samma administrator in forensic investigations. Samma cannot predict all the possible ways they might be used by a Samma owner. Some fields are common to all Solo outputs, e.g., Enable and StopOnError, and have common meanings (see Encoder1 section above).

<DeviceIPAddress>localhost</DeviceIPAddress>
<DeviceIPPort>8000</DeviceIPPort>
<UserRelativeTo>JPEG 2000</RelativeTo>
<OutputPath>f:\cache\JPEG 2000</OutputPath>
<Standard>0</Standard>
<Resolution>8</Resolution>
<BitRateProfile>0</BitRateProfile>
<MxfDictionary>C:\JPEG 2000\bin\mxf_file.bin</MxfDictionary>
<EncodeFirmware>C:\JPEG 2000\bin\encode_2_9_2.sea</EncodeFirmware>
<DecodeFirmware>C:\JPEG 2000\bin\decode_2_4_12.sea</DecodeFirmware>
<EmbeddedAudio>1</EmbeddedAudio>
<JPEG 2000Format>j2c</JPEG 2000Format>
<Preview>1</Preview>
<AdditionalFlags>-agr 1 -apa 1 -asb 16 -ppt</AdditionalFlags>
<SuccessPath>f:\success</SuccessPath>
<MoveOnSuccess>1</MoveOnSuccess>
<CheckBitRate>0</CheckBitRate>
<MinBitRate>0</MinBitRate>
<BitRateDuration>10</BitRateDuration>
<EnableSHA-1>1</EnableSHA-1>

Setting, to enable a SHA-1 checksum. Value=1 means yes. Value=0 means no.
<Enable>1</Enable>

Setting, to enable this output in this migration. Value=1 means yes. Value=0 means no.
<StopOnError>1</StopOnError>

Footer closing this section about this Solo's second output.

Header opening this section about this Solo's third output, indicating how this encoder was set up by an administrator before this migration. The fields below correspond to the VELA encoder's setup application called MXProps, and are not meant to be changed by a migration user since they are probably intended to remain consistent with variables and thresholds set by a Samma administrator for an entire library of migrations. These fields can be used by an experienced Samma administrator in forensic investigations. Samma cannot predict all the possible ways they might be used by a Samma owner. Some fields are common to all Solo outputs, e.g., Enable and StopOnError, and have common meanings (see Encoder1 section above).

<Type>TYPE_VELA</Type>
<DeviceIPAddress>localhost</DeviceIPAddress>
<UserTitle>MPEG2</UserTitle>
<OutputPath>f:\cache\mpeg2</OutputPath>
<Proxies>wmv</Proxies>
<SuccessPath>f:\success</SuccessPath>
<MoveOnSuccess>1</MoveOnSuccess>
<CheckBitRate>0</CheckBitRate>
<MinBitRate>0</MinBitRate>
<BitRateDuration>10</BitRateDuration>
<EnableSHA-1>1</EnableSHA-1>

Setting, to enable a SHA-1 checksum. Value=1 means yes. Value=0 means no.
<Enable>1</Enable>

Setting, to enable this output in this migration. Value=1 means yes. Value=0 means no.
<StopOnError>1</StopOnError>

Footer closing this section about this Solo's third output.

Header opening this section about this Solo's fourth output, indicating how this encoder was set up by an administrator before this migration. The fields below correspond to the VITEC encoder's setup application, and are not meant to be changed by a migration user since they are probably meant to remain consistent with variables and thresholds set by a Samma administrator for an entire library of migrations. These fields can be used by an experienced Samma administrator in forensic investigations. Samma cannot predict all the possible ways they might be used by a Samma owner. Some fields are common to all Solo outputs, e.g., Enable and StopOnError, and have common meanings (see Encoder1 section above).

<Type>TYPE_VITEC</Type>
<DeviceIPAddress>localhost</DeviceIPAddress>
<UserTitle>H.264</UserTitle>
<OutputPath>f:\cache\h264</OutputPath>
<SuccessPath>f:\success</SuccessPath>
<MoveOnSuccess>1</MoveOnSuccess>
<CheckBitRate>0</CheckBitRate>
<br:

<MinBitRate>0</MinBitRate>
<br:

<BitRateDuration>10</BitRateDuration>
<br:

<EnableSHA-1>1</EnableSHA-1>
<br:

Setting, to enable a SHA-1 checksum. Value=1 means yes. Value=0 means no.
<br:

<Enable>1</Enable>
<br:

Setting, to enable this output in this migration. Value=1 means yes. Value=0 means no.
<br:

<StopOnError>1</StopOnError>
<br:

Footer closing this section about this Solo’s fourth output.
<br:

<Encoder5>
<br:

Header opening this section about this Solo’s fifth output. In the next field this output is identified as a DVD recorder, not necessarily an encoder as might be implied from the title of this section. Other outputs above are video encoders. Some fields are common to all Solo outputs, e.g., Enable and StopOnError, and have common meanings (see Encoder1 section above).
<br:

<Type>TYPE_DVD</Type>
<br:

<DeviceIPAddress>localhost</DeviceIPAddress>
<br:

<DeviceIPPort>8006</DeviceIPPort>
<br:

<UserTitle>Direct DVD</UserTitle>
<br:

<Enable>0</Enable>
<br:

Setting, to enable this output in this migration. Value=1 means yes. Value=0 means no.
<br:

<StopOnError>1</StopOnError>
<br:

Footer closing this section about this Solo’s fifth output.
<br:

<Encoder6>
<br:

Header opening this section about this Solo’s sixth output. In the next field this output is identified as a GVG Profile, which is an example of an external encoder type. Some fields are common to all Solo outputs, e.g., Enable and StopOnError, and have common meanings (see Encoder1 section above).
<br:

<Type>TYPE_PROFILE</Type>
<br:

<DeviceIPAddress>localhost</DeviceIPAddress>
<br:

<DeviceIPPort>8005</DeviceIPPort>
<br:

<UserTitle>GVG Profile</UserTitle>
<br:

<Enable>0</Enable>
<br:

Setting, to enable this output in this migration. Value=1 means yes. Value=0 means no.
<br:

<StopOnError>1</StopOnError>
<br:

Footer closing this section about this Solo’s sixth output.
<br:

Footer closing this section about this Solo’s output files.
<br:

EncodedFiles>
<br:

Header opening this section about the files created in this migration.
<br:

<File0>
<br:

FILENAME>f:\success\654.560.784.03.10.mxf</FILENAME>
<br:

<Type>JPEG 2000</Type>
<br:

Location and filename of the JPEG 2000 file created in this migration.
<br:

<ShaDigest>17F67E916F263019AD37DD1DB2E932976DBEBBF1</ShaDigest>
<br:

<FileSize>14667316522</FileSize>
<br:

<Duration>35</Duration>
<br:

<AverageMuxRate>62970144</AverageMuxRate>
<br:

<File0>
<br:

SHA-1 checksum, file size, and end of File0 (JPEG 2000). These may be useful to compare with copies made from this file.
<br:

<File1>
<br:

FILENAME>f:\success\654.560.784.03.10.mpg</FILENAME>
<br:

<Type>MPEG2</Type>
<br:

Location and filename of the MPEG-2 file created in this migration.
<ShaDigest>7E0B00098285F1A96781EE14F23ADF3B1DC1EE8E</ShaDigest>
<FileSize>1208227101</FileSize>
<Duration>35</Duration>
<AverageMuxRate>513312</AverageMuxRate>
</File1>

SHA-1 checksum, file size, and end of File1 (MPEG-2). These may be useful to compare with copies made from this file.

<File2>
    <Filename>f:\success\654.560.784.03.10.wmv</Filename>
    <Type>WINDOWS_MEDIA</Type>
</File2>

Location and filename of the Windows Media 9 file created in this migration.

<ShaDigest>D56298D564C91AE4F5554981D2F79F074BD99574</ShaDigest>
<FileSize>367024292</FileSize>
<Duration>35</Duration>
<AverageMuxRate>778504</AverageMuxRate>
</File2>

SHA-1 checksum, file size, and end of File2 (Windows Media 9). These may be useful to compare with copies made from this file.

</EncodedFiles>
Footer closing this section about the files created in this migration.

<FreezeFrames>
Header opening this section about the FreezeFrames.
    <Segment1>
        <MarkIn>00:00:00:25</MarkIn>
        <MarkOut>00:00:11:14</MarkOut>
        <Duration>319</Duration>
        <Comment>Segment1_00:00:00:25-00:00:11:14</Comment>
    </Segment1>
Footer closing this section about the FreezeFrame.
</FreezeFrames>

<ShotLists>
Header opening this section about the shotlist.
    <Segment1>
        <MarkIn>00:00:05:02</MarkIn>
        <MarkOut>00:00:07:07</MarkOut>
        <Duration>55</Duration>
        <Comment>Segment1_00:00:05:02-00:00:07:07</Comment>
    </Segment1>
Footer closing this section about segment.
</ShotLists>

Footer closing this section about the shotlist.
<Segment1>
Mark In time for this segment.
<MarkIn>00:46:14:18</MarkIn>
Mark Out time for this segment.
<MarkOut>00:46:16:19</MarkOut>
Duration for this segment in Frame.
<Duration>51</Duration>
Summary of Mark In, Mark Out and name for this segment.
<Comment>Segment1_00:46:14:18-00:46:16:19</Comment>
Footer closing this section about segment.
</Segment1>
</BlackDetections>
</AudioSilences>
<header>
Segment1
Mark In time for this segment.
<MarkIn>00:00:00:26</MarkIn>
Mark Out time for this segment.
<MarkOut>00:00:00:26</MarkOut>
Duration for this segment in Frame.
<Duration>26</Duration>
Summary of Mark In, Mark Out and name for this segment.
<Comment>Segment1_-00:00:00:26</Comment>
Footer closing this section about segment.
</Segment1>
</AudioSilences>
</AudioActives>
</Metadata>
</Log>
</Header opening this section about the Log of this migration.
Using Source VTR: VTR3_BVW-65_SN13917\xD\xA0A17:18:32 Using Analysis Engine: I073907\xD\xA0A17:18:32 Rewinding source tape...\xD\xA0A17:18:35 Source tape stopped\xD\xA0A17:18:35 JPEG 2000 cued for record OK\xD\xA0A17:18:40 MPEG2 cued for record OK\xD\xA0A17:18:41 Enabled metadata\xD\xA0A17:18:41 Playing source tape...\xD\xA0A17:18:46 JPEG 2000 recording...\xD\xA0A17:18:46 MPEG2 recording...\xD\xA0A17:49:04 Source VTR has stopped playing\xD\xA0A17:49:04 Stopping migration\xD\xA0A17:49:04 Stopped metadata analysis\xD\xA0A17:56:47 JPEG 2000 Post processing completed successfully\xD\xA0A17:56:47 Migration completed SUCCESSFULLY at 2007-12-18 17:56:48\xD\xA0O.</Contents>

This log summary was displayed to the user on this Solo's screen during this migration (right-side box.)

Value is hours:minutes:seconds.

Footer closing this section about the Log of this migration.

Long names of the values logged in the Samples below.
SV=0</Sample6>  

<Sample7>IX=7 TC=191 IN=1 TT=L05:00:09:03 TB=00010225 RF=2 RW=1 RA=1  
HW=0 LA=103 LP=237 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=243 UM=14 UA=131 VP=238 VM=8  
VA=125 NR=62 MD=1 A1=142 A2=140 P1=1109 P2=1191 S1=0 S2=0 A3=0 A4=1 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample7>  

<Sample8>IX=8 TC=192 IN=1 TT=L05:00:09:04 TB=00010225 RF=2 RW=1 RA=1  
HW=0 LA=103 LP=237 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=243 UM=12 UA=131 VP=239 VM=8  
VA=125 NR=62 MD=1 A1=480 A2=496 P1=3680 P2=3855 S1=0 S2=0 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample8>  

<Sample9>IX=9 TC=193 IN=1 TT=L05:00:03:21 TB=00010225 RF=2 RW=1 RA=1  
HW=0 LA=105 LP=235 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=243 UM=12 UA=132 VP=240 VM=8  
VA=125 NR=62 MD=1 A1=779 A2=806 P1=3771 P2=3940 S1=0 S2=0 A3=0 A4=1 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample9>  

<Sample10>IX=10 TC=194 IN=1 TT=L05:00:03:22 TB=00010225 RF=2 RW=1 RA=1  
HW=0 LA=103 LP=235 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=243 UM=12 UA=132 VP=240 VM=7  
VA=125 NR=62 MD=1 A1=134 A2=1070 P1=3762 P2=3928 S1=0 S2=0 A3=1 A4=1 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample10>  

54,626 more lines like those above and below were deleted to make this sample .xml file a manageable size.

<Sample54632>IX=54632 TC=32 IN=1 TT=L05:30:42:06 TB=00010225 RF=2 RW=1  
RA=1 HW=0 LA=40 LP=42 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=128 UM=127 UA=127 VP=128  
VM=127 VA=127 NR=62 MD=0 A1=8 A2=7 P1=12 P2=12 S1=1 S2=1 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample54632>  

<Sample54633>IX=54633 TC=33 IN=1 TT=L05:30:42:07 TB=00010225 RF=2 RW=1  
RA=1 HW=0 LA=40 LP=42 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=128 UM=127 UA=127 VP=128  
VM=127 VA=127 NR=62 MD=0 A1=8 A2=7 P1=12 P2=12 S1=1 S2=1 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample54633>  

<Sample54634>IX=54634 TC=34 IN=1 TT=L05:30:42:08 TB=00010225 RF=2 RW=1  
RA=1 HW=0 LA=39 LP=41 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=128 UM=127 UA=127 VP=128  
VM=127 VA=127 NR=62 MD=0 A1=7 A2=6 P1=11 P2=11 S1=1 S2=1 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample54634>  

<Sample54635>IX=54635 TC=35 IN=1 TT=L05:30:42:09 TB=00010225 RF=2 RW=1  
RA=1 HW=0 LA=40 LP=41 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=128 UM=127 UA=127 VP=128  
VM=127 VA=127 NR=62 MD=0 A1=7 A2=6 P1=11 P2=11 S1=1 S2=1 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample54635>  

<Sample54636>IX=54636 TC=36 IN=1 TT=L05:30:42:10 TB=00010225 RF=2 RW=1  
RA=1 HW=0 LA=40 LP=41 DN=0 DL=0 MH=0 DW=1 DA=1 CP=0 UP=128 UM=127 UA=127 VP=128  
VM=127 VA=127 NR=62 MD=0 A1=7 A2=6 P1=11 P2=11 S1=1 S2=1 A3=0 A4=0 P3=0 P4=0 S3=1 S4=1  
SV=0</Sample54636>  

</Data>

Footer closing this section about the frame-by-frame Samples in this migration.

Footer closing this section about the metadata associated with this migration.

</SammaSolo>

Device footer, closing this migration's xml file.
Appendix D: SAMMA Metadata Format

Metadata is carried in multiplex channel 'T' so a metadata message has the form:

\[ i \ T \ T \ c \ c \ \text{data} \]

where \( c \ c \) is the two digit count of characters in the data.

The output stream contains metadata for each frame separated by a new line. The frame data consists of various Tags followed by the corresponding data in decimal representation and a space if a further Tag follows, for example:

```plaintext
TagDataTagDataTagDataTagData
TC=202 IN=1 LA=96 LP=176
TC=203 IN=1 LA=108 LP=195
TC=204 IN=0
TC=205 IN=0
```

Within each white-space delimited field: Tags are always two characters long and the third character is the \( [=] \) sign. Values are variable-length decimal sequences. Fields are not reported if they have no meaningful content.

- **RF level Range**: 0 – 255 where 0 = no RF, 255 = 1.2V pk-pk.
- **RW RF level warning Range**: 0 – 1 where 0 is okay. 1 = RF level < threshold RF warn level (range is 0.2 to 0.4V pk-pk).
- **RA RF level alarm Range**: 0 – 1 where 0 is okay. 1 = RF level < threshold RF alarm level (range 0.2 to 0.4V pk-pk).
- **HW RF Head difference warning Range**: 0 – 1 where 0 is okay. 1 = head to head difference > threshold RF Diff level (range is 50% to 80% - TBD).
- **DL DOC length Range**: 0 – 255 represents 0 - 75us. Measured in 0.3us steps.
- **DN DOC number**: Number of drop-outs detected each frame. Range 0 – 255 with clipping at 255.
- **DW DOC warning Range**: 0 – 1 where 0 is okay. 1 = maximum drop out length in one frame exceeds threshold DOC warn level (range is 20us to 75us - TBD).
- **DA DOC alarm Range**: 0 – 1 where 0 is okay. 1 = maximum drop out length in one frame exceeds threshold DOC alarm level (range is 20us to 75us - TBD).
- **MH Missing H pulse count Range**: 0 – 255 missing syncs per frame (clips at 255).
- **NR Noise Level Range**: 0 – 63 represents unweighted random noise. See Table1 below
- **MD Motion Detect Range**: 0 – 1 where 0 = no motion, 1 = motion.
- **LA Luminance Average Range**: 0 – 255 where 16 = black, 235 = white.
- **LP Luminance Peak Range**: 0 – 255 where 16 = black, 235 = white.
- **UP Chroma U Maximum Range**: 0 – 255 where 128 = black.
- **UM Chroma U Minimum Range**: 0 – 255 where 128 = black.
- **UA Chroma U Average Range**: 0 – 255 where 128 = black.
- **VP Chroma V Maximum Range**: 0 – 255 where 128 = black.
- **VM Chroma V Minimum Range**: 0 – 255 where 128 = black.
- **VA Chroma V Average Range**: 0 – 255 where 128 = black.
- **A1 Audio Ch1 Average Range**: 0 – 65535 Where 0 is no audio, and 65535 is 0dB FS. Represents top 16 bits of audio signal.
- **A2 Audio Ch2 Average Range**: 0 – 65535 Where 0 is no audio, and 65535 is 0dB FS. Represents top 16 bits of audio signal.
- **P1 Audio Ch1 Peak Range**: 0 – 65535 Where 0 is no audio, and 65535 is 0dB FS. Represents top 16 bits of audio signal.
- **P2 Audio Ch2 Peak Range**: 0 – 65535. Where 0 is no audio, and 65535 is 0dB FS. Represents top 16 bits of audio signal.
- **S1 Audio Ch1 Silence Range**: 0 – 1. Where 1 is audio silence detected. Silence detection level set at -66db.
- **S2 Audio Ch2 Silence Range**: 0 – 1. Where 1 is audio silence detected. Silence detection level set at -66db.

**TT Timecode Tape Time String** = xHH:MM:SS:FF Where x= Source: V=VITC, L=LTC, G=Gen HH = Hours, MM=Minutes, SS=Seconds, FF=Frames.

**TC_DISPLAY** = .HH:MM:timecode, FF will be Leading Source character ignored FF will be set.
**TB Timecode binary** (user) groups String[16] = hhhhhhhh where h is hex (upper case).

**TC_BINARY**=hhhhhhhh.

**IN Input Present Range** 0 – 1, where 0 is input missing, 1 is input present.

**CP Colour Present Range** 0 – 1, where 0 is color carrier not detected, 1 is color carrier detected.

**TC Frame Count Range** 0 – 255, increasing by one modulo 256 for each frame. Counter is in hardware so can be used as measure of (software & link layer) dropped data.

**Table 1: Metadata Noise Level interpretation:**

<table>
<thead>
<tr>
<th>S/N NR values</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; -48dB</td>
<td>0</td>
</tr>
<tr>
<td>&lt;= -45dB &amp; &gt; -47dB</td>
<td>1</td>
</tr>
<tr>
<td>-40 dB</td>
<td>3</td>
</tr>
<tr>
<td>-38 dB</td>
<td>5</td>
</tr>
<tr>
<td>-35 dB</td>
<td>8</td>
</tr>
<tr>
<td>-30 dB</td>
<td>16</td>
</tr>
<tr>
<td>-28 dB</td>
<td>20</td>
</tr>
<tr>
<td>-24 dB</td>
<td>31</td>
</tr>
<tr>
<td>-19 dB</td>
<td>40</td>
</tr>
</tbody>
</table>
Appendix E: SAMMA CSV Import Format

Comma Separated Variables (CSV) Import Format Version 1.1 for SAMMAsolo and Robot.

This section describes the tape database import file format required for the SAMMAsolo and Robot. The file is ASCII encoded and comprised of a list of field names on the very first line of the file followed by a list of field data for each entry per line. The very first character of the first line specifies the separating character (normally a comma) and therefore no field values can contain this character.

Some of the fields have user-definable display labels on Solo screens, and custom field names can be mapped to four internal fields (see ‘custom label’ notations below).

Except for umid and tapeid, these fields can be in any order. The available field names are:

- **umid**
  Unique identifier or barcode value (ASCII). Cannot be blank and required as the first field.

- **tapeid**
  Tape ID (ASCII). Cannot be blank and required as the second field.

- **tapeid_sequence**
  Tape sequence, if any, e.g., “1 of 2”. (Optional)

- **passed_inspection**
  Flag to indicate tape has passed inspection. In a SAMMAsolo this flag can be over-written by the user with a checkbox on the ‘Tape Details’ screen. In a SAMMA Robot this flag controls whether the tape may be migrated or not. A single ‘t’ or ‘1’ character denotes a ‘TRUE’ status. (Optional, defaults to TRUE.)

- **cleaned**
  Flag to indicate tape has been cleaned. This flag can be set by the user with a checkbox on the ‘Tape Details’ screen. In a SAMMAsolo this flag controls whether the tape will be cleaned if the Robot contains a cleaner. A single ‘t’ or ‘1’ character denotes a ‘TRUE’ status. (Optional, default to FALSE.)

- **cleaned_result**
  Text field to indicate any cleaning errors. (Optional)

- **cleaned_date**
  Time and date when the tape was cleaned. In the format YYYY-MM-DD HH:MM:SS. (Optional)

- **migrated**
  Flag to indicate whether the tape has been migrated successfully. A single character of ‘t’ or ‘1’ indicates a TRUE status. (Optional, defaults to FALSE.)

- **migrated_result**
  Text field to indicate any migration errors. (Optional)

- **migrated_date**
  Time and date of when the tape was migrated. In the format YYYY-MM-DD HH:MM:SS. (Optional)

- **migrated_by**
  Name of user who migrated the tape. (Optional)

- **migrated_log**
  Any log information of the migrated tape. (Optional)

- **migrated_devices**
  Device information such as serial numbers of devices used for the migration. Each device is separated with a semi-colon. (Optional)

- **author (custom label)**
  Name of author or originator of the tape. This is a custom label field that maps to the “AuthorLabel” parameter in the SammaRobot.ini and SammaSolo.ini configuration files. (Optional)

- **location (custom label)**
  Location information of the tape. This is a custom label field that maps to the “LocationLabel” parameter in the SammaRobot.ini and SammaSolo.ini configuration files. (Optional)

- **description (custom label)**
  Description of the contents of the tape. This is a custom label field that maps to the “DescriptionLabel” parameter in the SammaRobot.ini and SammaSolo.ini configuration files. (Optional)

- **comments (custom label)**
  Any additional comments or information for the tape. This is a custom label field that maps to the “CommentsLabel” parameter in the SammaRobot.ini and SammaSolo.ini configuration files. (Optional)

- **output_filename**

The file name to be used for the migration. If not present, the Tape ID will be used. Must not contain any invalid filename characters. (Optional)

**Example**  
Minimum field requirements:  
,umid,tapeid  
1234567890,Bars Test Tape  
0987654321,Day at the Races  
With optional fields (missing fields must still be enclosed with the correct number of separators):  
^umid^tapeid^passed_inspection^cleaned^author^description^comments  
1234567890^Bars Test Tape^t^f^^^This comment has commas,, in it!  
0987654321^Day at the Races^t^f^John Smith^Racing at Kempton^Taken 13/12/2006
Appendix E: Tape Segment Migration Setup from database

Within the SAMMA database, there is a table called “TapeSegments” which holds the Mark-in, Mark-out and Duration values for a tape. Whenever Solo retrieves information for an UMID or tape ID, it will check if the UMID exists in the TapeSegments table exists and if its state is equal to 1 (pending), the Mark-in, Mark-out or Duration and Clip Filename will be loaded and used for this migration. When the migration completes successfully, Solo will change the clip state to the value 2.

Table definition: TapeSegments

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>umid</td>
<td>text</td>
<td></td>
<td>umid / barcode</td>
</tr>
<tr>
<td>clip_index</td>
<td>integer</td>
<td></td>
<td>index starting from 0</td>
</tr>
<tr>
<td>markin</td>
<td>text</td>
<td></td>
<td>Mark-in time code in the format: 00:00:01:01</td>
</tr>
<tr>
<td>markout_duration</td>
<td>text</td>
<td></td>
<td>Mark-out time code in the format: 00:03:00:00 or Duration: D00:05:00</td>
</tr>
<tr>
<td>clip_name</td>
<td>text</td>
<td></td>
<td>Description (optional)</td>
</tr>
<tr>
<td>state</td>
<td>integer</td>
<td>0</td>
<td>0=no state, 1=pending, 2=done</td>
</tr>
<tr>
<td>clip_filename</td>
<td>text</td>
<td></td>
<td>(optional) filename for this clip</td>
</tr>
</tbody>
</table>

The “clip_filename” may be defined by the use of the following macros:

%cliptext0clip_index from “TapeSegments” table
%cliptext1output_filename from “Tapes” table
%cliptext2clip_name from “TapeSegments” table
%cliptext3date: YYYYMMDD
%cliptext4time: HHMMSS
%cliptext5umid from “TapeSegments” table

Example:

<table>
<thead>
<tr>
<th>umid</th>
<th>clip_index</th>
<th>markin</th>
<th>markout_duration</th>
<th>clip_name</th>
<th>state</th>
<th>clip_filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>030304B01629B1DC</td>
<td>0</td>
<td>00:00:01:01</td>
<td>00:02:01:03</td>
<td>Interview P1</td>
<td>1</td>
<td>%N_%i</td>
</tr>
<tr>
<td>030304B01629B1DC</td>
<td>1</td>
<td>00:04:00:01</td>
<td>D00:10:00</td>
<td>Interview P2</td>
<td>1</td>
<td>%N_%i</td>
</tr>
<tr>
<td>484F49B3F2E8D6145</td>
<td>0</td>
<td>00:05:01:03</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Tape Segment Migration Setup Steps:

1. Go Start-> All Program-> PostgreSQL 8.4-> pgAdmin III
2. Click Servers -> PostgreSQL

3. Input “postgres” as password if “Connect to Server” window is prompted.

4. Select TapeSegments under Databases-> SammaCustomer-> Schemas_> Public-> Tables-> TapeSegments

5. With TapeSegments Highlighting, click View the data in the selected object icon on toolbar

6. Add/Edit the data in the TapeSegment table.

7. After completion, click the Save Icon on the toolbar
Appendix F: Networking Multiple SAMMAsolos

Solo is built on standard IT tools and best practices such as Internet Protocols (IP), network drive mapping (a common [G] drive, etc.) by Universal Naming Convention (UNC), Remote Procedure Calls (RPCs), Windows XP file system (NTFS), etc. As a result, Solos can be networked together so one user can operate up to 16 Solos from one seat.

The theory of operation for networked Solos is similar to descriptions in Getting Started with SAMMAsolo, Making Changes to a SAMMAsolo and other chapters in this manual. There are minor differences where networked Solos share a database and an optional barcode scanner.

The Oracle Customer Service Team can assist the user with a custom package of .sxt templates, RPCs, drivers and IP addresses. Networked Solos can be configured so the user can run one SammaSolo.exe to open XML templates and files on different Solos, or if preferred, run multiple instances of SammaSolo.exe on one Windows desktop.

Only the master Solo needs a keyboard, VGA monitor and mouse (KVM) for normal operation. For maintenance purposes, if required, networked Solos can share the master Solo’s KVM on a KVM switch, or simply use spare KVMs.

Each networked Solo needs its own source VTR, and if used, a Dub VTR or external encoder. All the connections described in Appendix A: Solo Connections apply except for the KVM and barcode scanner considerations mentioned above.

Every networked Solo’s internal storage can be used and shared. Every Solo has an SQL database installed but when networked, only one Solo’s SQL database should be used. Networked Solo initialization files (.ini) should be configured to refer to one Solo’s database.
Appendix G: SAMMA solo Technical Specification

SELECTABLE SIGNAL PROCESSING:
- RF Dropout Compensation
- Full Frame Synchronizer
- Time Code Generator
- Signal Analyzer
- Digital Comb Filter
- AGC (Auto Gain Control)
- ACC (Auto Chroma Control)
- CTI (Chroma Transition Improvement)
- NR (Digital Noise Reduction)

SUPPORTED TELEVISION STANDARDS:
- NTSC, NTSC-J
- PAL, PAL-N, PAL-M
- SECAM

SUPPORTED TAPE FORMATS:
Including but not limited to:
- 2" Quadruplex
- 1" Type A, B or C
- 3/4" U-matic
- Betacam, Betacam SP/SX, Digital Betacam
- VHS, S-VHS
- Video-8, Hi-8

SERIAL VTR CONTROL:
- Sony 9 pin RS-422 for source VTR (1)
- Sony 9 pin RS-422 for record VTR (3)

Firewire VTR CONTROL:
- Firewire for DVCAM VTR (1)

VIDEO & AUDIO INPUTS:
- Analog composite video, CVBS (2 BNCs)
- Analog component video, Y/PB/PR (1 input on 3 BNCs)
- Y/C (1 S-Video multi-pin connector)
- 4 channels Balanced Analog Audio (4 XLRs)
- RF (1 BNC)
- Digital Component (SDI)

VIDEO & AUDIO OUTPUTS (see also optional JPEG 2000 card below for more outputs):
- SDI OUT (copy of SDI fed to all encoders), CCIR 601 with embedded audio 4 ch 16 bit PCM (1 BNC)
- Analog composite video output, CVBS (1 BNC)
- Analog component video, Y/PB/PR (1 output on 3 BNCs)
- Y/C (1 S-Video multi-pin connector)
- 4 channels Balanced Analog Audio (4 XLRs)
- SMPTE Time Code (1 XLR)

TIME CODE INPUTS:
- SMPTE Time Code (1 XLR)
- VITC (1 BNC)
- LTC (1 BNC)

COMPUTER INTERFACES:
- Analog VGA output (HD15F 15-pin connector)
- Digital video output (DVI-D)
- USB
- PS/2 keyboard and mouse
- 3.5mm stereo audio out

COMPUTER NETWORK INTERFACE:
- 10/100/1000BASE-T Gigabit Ethernet (2 RJ-45 connectors)
STORAGE:
- Internal ~1 TB RAID-0 disk array

STANDARD COMPUTER PERIPHERALS:
- VGA Monitor
- Full-size 102-key Keyboard
- 2-button mouse

OPERATING SYSTEM:
- Windows XP (SP3)

OPTIONAL INTERNAL ENCODERS:
- JPEG2000 Encoder/Decoder
  - 8 or 10 bit quantization, JP2 and J2C formats
  - Reversible 5x3 (lossless), Irreversible 9x7, Irreversible 5x3 wavelets
  - Constant quality or constant bit rate
  - JPEG2000 SDI OUT CCIR 601 SDI with embedded audio 4 ch 16 bit PCM (1 BNC)
  - JPEG2000 AUDIO OUT 4 channels AES/EBU Audio (8 XLRs on SAMMA breakout cable from D-sub 15 on Solo)
  - File format / wrapper: MXF
- SAMMA Multcoder (Not all of the formats below can be used simultaneously. Oracle has built and tested a number of templates using combinations of the file formats and wrappers below. See template info elsewhere in this manual for details.)
  - Compression formats
    - Uncompressed Video
    - AVI
    - MPEG-1
    - MPEG-2
    - MPEG-4 (H.264)
    - Windows Media 9
    - Real Media
    - Flash 8
    - Wrappers
    - QuickTime
    - MXF
- Grass Valley AMP protocol control of GVG Profile (contact Oracle for others)

POWER REQUIREMENTS:
- 100 to 240 VAC 50 to 60 Hz

OPTIONAL ACCESSORIES:
- SAMMA JPEG2000-MXF Hardware Player™ (PCI card w/ software for Windows XP)
- SAMMA Clean™ U-matic Videotape Archive Quality Cleaner
- SAMMA Clean™ Betacam Videotape Archive Quality Cleaner
- SAMMA Prep™ Videotape Accessioning and Inspection Station
- USB Barcode Scanner
- LCD Monitor.
### Appendix H: Error Code

#### J2K Encoder Errors

<table>
<thead>
<tr>
<th>Code</th>
<th>Brief Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
<td>No error</td>
</tr>
<tr>
<td>-1</td>
<td>Error</td>
<td>Generic error</td>
</tr>
<tr>
<td>-2</td>
<td>Error getting status information on a file.</td>
<td></td>
</tr>
<tr>
<td>-3</td>
<td>Parsing Error</td>
<td></td>
</tr>
<tr>
<td>-4</td>
<td>Encoder failed to start!</td>
<td></td>
</tr>
<tr>
<td>-5</td>
<td>Device is already in use!</td>
<td></td>
</tr>
<tr>
<td>-100</td>
<td>Failed to create destination file %s</td>
<td></td>
</tr>
<tr>
<td>-101</td>
<td>Failed to open source file %s!</td>
<td></td>
</tr>
<tr>
<td>-102</td>
<td>Copy error, wrote %ld out of %ld bytes.</td>
<td></td>
</tr>
<tr>
<td>-103</td>
<td>Failed to add HASH data!</td>
<td></td>
</tr>
<tr>
<td>-104</td>
<td>CryptCreateHash failed!</td>
<td></td>
</tr>
<tr>
<td>-105</td>
<td>CryptAcquireContext failed!</td>
<td></td>
</tr>
<tr>
<td>-106</td>
<td>Failed to allocate %lu of memory!</td>
<td></td>
</tr>
<tr>
<td>-107</td>
<td>Rename on same drive failed.</td>
<td></td>
</tr>
<tr>
<td>-110</td>
<td>Thread already running</td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>Unknown error</td>
<td></td>
</tr>
<tr>
<td>2002</td>
<td>Card API Start error (no input)</td>
<td>No input from the J2K card</td>
</tr>
<tr>
<td>2003</td>
<td>MXFInvalidFormat</td>
<td></td>
</tr>
<tr>
<td>2004</td>
<td>MXFInvalidFormat</td>
<td></td>
</tr>
<tr>
<td>2005</td>
<td>NotLicensed</td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>InvalicCallbackParameter</td>
<td></td>
</tr>
<tr>
<td>3001</td>
<td>CardCaptureDataLostByDriver</td>
<td></td>
</tr>
<tr>
<td>3002</td>
<td>CardCaptureDataDroppedByUser</td>
<td></td>
</tr>
<tr>
<td>3003</td>
<td>CardCaptureInputLost</td>
<td></td>
</tr>
<tr>
<td>3004</td>
<td>CardCaptureDataCorrupt</td>
<td></td>
</tr>
<tr>
<td>3005</td>
<td>CardCaptureUnknownError</td>
<td></td>
</tr>
<tr>
<td>4002</td>
<td>Failed to open file %s</td>
<td></td>
</tr>
<tr>
<td>4003</td>
<td>NULL filename!</td>
<td></td>
</tr>
<tr>
<td>4004</td>
<td>File write failed!</td>
<td></td>
</tr>
</tbody>
</table>

#### SME Encoder Errors

<table>
<thead>
<tr>
<th>Code</th>
<th>Brief Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
<td>No error</td>
</tr>
<tr>
<td>-1</td>
<td>Error</td>
<td>Generic error</td>
</tr>
<tr>
<td>-2</td>
<td>Problem getting information</td>
<td></td>
</tr>
<tr>
<td>-3</td>
<td>Device is already in use!</td>
<td></td>
</tr>
<tr>
<td>-51</td>
<td>RpcDRInit Error!</td>
<td></td>
</tr>
<tr>
<td>-52</td>
<td>RpcDRSetEncodeParams Error!</td>
<td></td>
</tr>
<tr>
<td>-53</td>
<td>RpcDRRecordStart Error!</td>
<td></td>
</tr>
<tr>
<td>-54</td>
<td>RpcDRRecordStop Error!</td>
<td></td>
</tr>
<tr>
<td>-55</td>
<td>RpcDRGetStatus Error!</td>
<td></td>
</tr>
<tr>
<td>-100</td>
<td>Failed to create destination file %s.</td>
<td></td>
</tr>
<tr>
<td>-101</td>
<td>Failed to open source file %s!</td>
<td></td>
</tr>
<tr>
<td>-102</td>
<td>Copy error, wrote %ld out of %ld bytes.</td>
<td></td>
</tr>
<tr>
<td>-103</td>
<td>Failed to add HASH data!</td>
<td></td>
</tr>
<tr>
<td>-104</td>
<td>CryptCreateHash failed!</td>
<td></td>
</tr>
<tr>
<td>-105</td>
<td>CryptAcquireContext failed!</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Brief Description</td>
<td>Explanation</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>-106</td>
<td>Failed to allocate %lu of memory!</td>
<td></td>
</tr>
<tr>
<td>-110</td>
<td>Thread already running</td>
<td></td>
</tr>
<tr>
<td>-207</td>
<td>Failed to load project %s</td>
<td></td>
</tr>
<tr>
<td>-208</td>
<td>Failed to Cue encoders</td>
<td></td>
</tr>
<tr>
<td>-209</td>
<td>Failed to create temporary project file %s</td>
<td></td>
</tr>
<tr>
<td>-210</td>
<td>Failed to Start encoders</td>
<td></td>
</tr>
<tr>
<td>-212</td>
<td>Encoders failed to stop! Waiting for post-processing.</td>
<td></td>
</tr>
<tr>
<td>-213</td>
<td>Not encoding!</td>
<td></td>
</tr>
<tr>
<td>-214</td>
<td>Dropped %ld frames!</td>
<td></td>
</tr>
<tr>
<td>-215</td>
<td>Failed to set Video Standard %s</td>
<td></td>
</tr>
<tr>
<td>-216</td>
<td>App is not launched or responding!!</td>
<td></td>
</tr>
<tr>
<td>-217</td>
<td>Invalid instance for Start!</td>
<td></td>
</tr>
<tr>
<td>-219</td>
<td>Invalid instance for GetStatus!</td>
<td></td>
</tr>
<tr>
<td>-220</td>
<td>Post-processing busy!</td>
<td></td>
</tr>
<tr>
<td>-221</td>
<td>Post-processing timed out!</td>
<td></td>
</tr>
<tr>
<td>-301</td>
<td>Profile 1 is not encoding!</td>
<td></td>
</tr>
<tr>
<td>-401</td>
<td>Profile 2 is not encoding!</td>
<td></td>
</tr>
<tr>
<td>-501</td>
<td>Profile 3 is not encoding!</td>
<td></td>
</tr>
<tr>
<td>-601</td>
<td>Profile 4 is not encoding!</td>
<td></td>
</tr>
</tbody>
</table>

**Vela Encoder Errors**

<table>
<thead>
<tr>
<th>Code</th>
<th>Brief Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
<td>No error</td>
</tr>
<tr>
<td>-1</td>
<td>Error</td>
<td>Generic error</td>
</tr>
<tr>
<td>-2</td>
<td>Problem getting information</td>
<td></td>
</tr>
<tr>
<td>-5</td>
<td>Device is already in use!</td>
<td></td>
</tr>
<tr>
<td>-100</td>
<td>Failed to create destination file %s. (Error -100)</td>
<td></td>
</tr>
<tr>
<td>-101</td>
<td>Failed to open source file %s! (Error -101)</td>
<td></td>
</tr>
<tr>
<td>-102</td>
<td>Copy error, wrote %ld out of %ld bytes. (Error -102)</td>
<td></td>
</tr>
<tr>
<td>-103</td>
<td>Failed to add HASH data! (Error -103)</td>
<td></td>
</tr>
<tr>
<td>-104</td>
<td>CryptCreateHash failed! (Error -104)</td>
<td></td>
</tr>
<tr>
<td>-105</td>
<td>CryptAcquireContext failed! (Error -105)</td>
<td></td>
</tr>
<tr>
<td>-106</td>
<td>Failed to allocate %lu of memory! (Error -106)</td>
<td></td>
</tr>
<tr>
<td>-107</td>
<td>Rename on same drive failed. (Error -107)!</td>
<td></td>
</tr>
<tr>
<td>-110</td>
<td>Thread already running</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Error on starting the MxClient</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Error on initialise the MxClient</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Encoder Component Failed Loading Parameters, Error = %ld</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Error Cueing video</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Error starting encoder, error = %ld</td>
<td></td>
</tr>
</tbody>
</table>

**H264 Errors**

<table>
<thead>
<tr>
<th>Code</th>
<th>Brief Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK</td>
<td>No error</td>
</tr>
<tr>
<td>-1</td>
<td>Error</td>
<td>Generic error</td>
</tr>
<tr>
<td>-100</td>
<td>Failed to create destination file %s. (Error -100)</td>
<td></td>
</tr>
<tr>
<td>-101</td>
<td>Failed to open source file %s! (Error -101)</td>
<td></td>
</tr>
<tr>
<td>-102</td>
<td>Copy error, wrote %ld out of %ld bytes. (Error -102)</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Brief Description</td>
<td>Explanation</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>0</td>
<td>OK</td>
<td>No error</td>
</tr>
<tr>
<td>-1</td>
<td>Error / Timeout</td>
<td>Generic error or Time out is reached</td>
</tr>
<tr>
<td>-2</td>
<td>VTR at port %s failed to respond!</td>
<td></td>
</tr>
<tr>
<td>-3</td>
<td>Port %s failed to initialise!</td>
<td></td>
</tr>
<tr>
<td>-4</td>
<td>Port %s failed to create!</td>
<td></td>
</tr>
<tr>
<td>-5</td>
<td>Port %s already in use!</td>
<td></td>
</tr>
<tr>
<td>SerialPortError = -1</td>
<td>Exception in CSerialPort::InitPort</td>
<td></td>
</tr>
<tr>
<td>SerialPortError = -2</td>
<td>Failed to open %s</td>
<td></td>
</tr>
<tr>
<td>SerialPortError = -3</td>
<td>Failed to retrieve status for %s</td>
<td></td>
</tr>
<tr>
<td>SerialPortError = -4</td>
<td>Failed to set comstate for %s</td>
<td></td>
</tr>
<tr>
<td>SerialPortError = -5</td>
<td>Failed to set timeouts for %s</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Code</th>
<th>Brief Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>General RPC failure.</td>
<td>Generic error</td>
</tr>
<tr>
<td>-11</td>
<td>RPC already in use.</td>
<td></td>
</tr>
<tr>
<td>-100</td>
<td>Failed to initialise encoder (TCP socket error)</td>
<td></td>
</tr>
<tr>
<td>-102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-105</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-106</td>
<td>GetStatus failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-107</td>
<td>GetVtrStatus failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-108</td>
<td>GetFileSize failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-109</td>
<td>GetRenameFileStatus failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-110</td>
<td>GetFreeDiskSpace failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-111</td>
<td>GetTotalDiskSpace failed due to invalid socket.</td>
<td></td>
</tr>
<tr>
<td>-201</td>
<td>Rename failed. Delete process failed.</td>
<td></td>
</tr>
<tr>
<td>-205</td>
<td>Profile not recording.</td>
<td></td>
</tr>
<tr>
<td>-206</td>
<td>GetStatus failed due to communication error.</td>
<td></td>
</tr>
<tr>
<td>-207</td>
<td>GetFileSize failed due to GetClipData response error.</td>
<td></td>
</tr>
<tr>
<td>-208</td>
<td>GetFreeDiskSpace failed due to comms error.</td>
<td></td>
</tr>
<tr>
<td>-209</td>
<td>GetTotalDiskSpace failed due to comms error.</td>
<td></td>
</tr>
</tbody>
</table>
CCIR 601
Digital component video standard for 525-line (NTSC) or 625-line (PAL/SECAM) standard definition video using 13.5 MHz sampling and a 4:2:2 YUV (Y, Pb, Pr) encoding scheme.

Composite Video or CVBS
Composite video, or CVBS (Composite Video Blanking and Sync), is a standard definition analog video format with brightness (luminance), color information (chrominance), blanking (non-active picture period) and sync (synchronization signals) combined into a single signal. While more convenient, composite video delivers lesser quality than Y/C or component video.

Component Video or Y/Pb/Pr
Component video is an analog video standard that is transmitted or stored as three separate signals: brightness (luminance or Y) and two half-resolution color-difference signals (Pb and Pr). Component video is the highest-quality analog video signal, and is preferred for interconnect compared to Y/C or composite video.

Drop Out
A drop out is a spurious picture defect resulting from partial loss of information in a frame or frames. Drop outs are caused by magnetic particles missing from the videotape due to tape damage or normal tape aging. Analog VTRs can compensate for drop outs by using information from the line above the drop out. This drop out compensation is sometimes detectable by the human eye, particularly if the drop out occurs over multiple lines within a frame or in highly detailed graphics. Digital VTRs correct drop outs with more arithmetical processes like error correction or error concealment.

Proc Amp
A Proc Amp, short for process amplifier, alters or corrects the basic components of a video picture: contrast, brightness, saturation, and hue.

SAMMA Analysis Engine™
The SAMMA Analysis Engine is a purpose-built device that performs several video and audio functions, including:

- NTSC/PAL decoding
- Analog-to-digital conversion
- Frame synchronization
- Time base correction
- Process amplifier adjustments
- Digital signal enhancements
- Comb filter
- Noise reduction
- Audio signal routing

The SAMMA Analysis Engine also feeds real-time data to SAMMA Eye, Solo's Data Analysis graphs and log, and Solo's XML files.

SAMMA Eye™
SAMMA Eye is an automated monitoring software application designed to free the user from constantly watching a migrating video for certain errors which may, over a period of user-selected time, indicate minor or major problems with the tape quality, or denote the likely end of useable content on the tape. Sensitivity thresholds and durations are user-configured and saved in templates. If those thresholds are exceeded,
SAMMA Eye can be configured to automatically terminate a migration, or continue the migration and just flag the events as errors in the migration’s XML log.

**SDI**

The Serial Digital Interface (SDI), standardized in ITU-R (CCIR) BT.656 and SMPTE 259M, is a standard for carrying a CCIR 601 standard definition digital video signal on a single cable terminated with BNC connectors. Embedded audio is optional.

**Solo Templates (.sxt files)**

Solo templates are a convenient way to reuse custom Solo settings for additional tape migrations. Solo templates are typically prepared by an administrator using SAMMA-supplied templates as a baseline or starting point, modifying them as required and saving them as user-defined templates. There is no limit to the number of templates a user can save, and they are human-readable XML. All SAMMA templates have the file extension .sxt. See also the chapter on Metadata.

**TBC**

A Time Base Corrector is hardware designed to reduce or eliminate errors caused by the mechanical instability inherent in analog recordings on mechanical media like videotape. Time base correctors buffer an incoming signal and then play it out from memory in sync with a stable reference signal or clock. Solo’s Analysis Engine contains a TBC.

**Time Code**

SMPTE Time Code (NTSC) and EBU Time Code (PAL, SECAM) are data streams recorded on videotapes (and more recently computer files) to identify each video frame and its intended duration. Time code has fields for hours (from 0 to 23), minutes (from 0 to 59), seconds (from 0 to 59), and frames (from 0 to 24 for PAL and 0 to 29 for NTSC). Longitudinal Time Code (LTC) is recorded on an audio track. Vertical Interval Time Code (VITC) stores the time code as a binary code in the vertical blanking portion of the video signal, and is more accurate than LTC for “jogging”. VITC is recommended if available from the source VTR. Best practices call for time code on a videotape to increment steadily from start to finish, but this is often not the case with older tapes. Time code errors and discontinuities can cause cueing errors and/or confusion to a VTR (and sometimes subsequently to a Solo as well).

**Videotape, construction and decay**

Videotape is enclosed in a cassette or wound on a reel and consists of a backing material, a binder, and a thin coating of magnetic particles. As tapes age they exhibit flaws including broken or jammed tape, wrinkles, layers of tape sticking to each other due to adhesive migration, and the slow failure of the binder to retain the magnetic particles on tape. These flaws, compounded by exposure to heat, light, and magnetic fields, cause the inevitable decline of playback quality until the tapes simply become unusable.

**VTR**

VTR is an abbreviation for videotape recorder, hardware that can record and play video and audio on magnetic tape. A play-only machine is also often called a VTR, as in this manual. Solo’s Source VTR can be either a player or player/recorder, although Solo does not record on a source VTR. If a tape copy of the migration is desired, a record-capable destination VTR (called Dub VTR) must be installed. See the chapter on Installing SAMMAsolo.

**Y/C Video**

Y/C video, also known as Separate-Video or Super-Video (S-Video), is an analog video signal that carries the video data as two separate signals: Y (brightness) and C (color). Y/C video is considered superior to composite video and inferior to component video.

**XML**

Extensible Markup Language (XML) is a standardized method for sharing structured data among different information systems; for example, almost all word processors and many applications (i.e., databases) natively read and write XML. Oracle uses XML as the structured container for all metadata collected during a migration, allowing straightforward data sharing between Solo and the user’s database(s). See the chapter Metadata: XML and Import/Export.